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KATA PENGANTAR

Puji syukur kami panjatkan ke hadirat Tuhan Yang Maha Esa atas karunia, petunjuk,
dan bimbingan-Nya sehingga Pusat Pengembangan dan Pemberdayaan Pendidik dan
Tenaga Kependidikan (PPPPTK) Matematika dapat mewujudkan modul pengelolaan
pembelajaran matematika untuk guru SD dan SMP. Pada penyusunan modul untuk
tahun 2010 telah tersusun sebanyak dua puluh judul, terdiri dari sepuluh judul untuk
guru SD dan sepuluh judul lainnya untuk guru SMP.

Modul-modul ini disusun dalam rangka memfasilitasi peningkatan kompetensi guru
SD dan SMP di forum Kelompok Kerja Guru (KKG) dan Musyawarah Guru Mata
Pelajaran (MGMP), khususnya KKG dan MGMP yang dikelola melalui program
Better Education through Reformed Management and Universal Teacher Upgrading
(BERMUTU). Modul yang telah tersusun, selain didistribusikan dalam jumlah
terbatas ke KKG dan MGMP, juga dapat diakses melalui website PPPPTK

Matematika dengan alamat www.p4tkmatematika.com.

Penyusunan modul diawali dengan kegiatan workshop yang menghasilkan
kesepakatan tentang daftar judul modul, sistematika penulisan modul, dan garis besar
(outline) isi tiap judul modul. Selanjutnya secara berturut-turut dilakukan kegiatan

penulisan, penilaian (telaah), editing, dan layouting modul.

Penyusunan modul melibatkan beberapa unsur, meliputi Widyaiswara dan staf
PPPPTK Matematika, Dosen Lembaga Pendidikan Tenaga Kependidikan (LPTK),
Widyaiswara Lembaga Penjaminan Mutu Pendidikan (LPMP), Guru SD dan Guru
Matematika SMP dari berbagai propinsi. Untuk itu, kami sampaikan penghargaan dan
terima kasih yang tak terhingga kepada semua pihak yang telah membantu

terwujudnya penyusunan modul tersebut.

Mudah-mudahan dua puluh modul tersebut dapat bermanfaat optimal dalam
peningkatan kompetensi para guru SD dan SMP dalam mengelola pembelajaran

matematika, sehingga dapat meningkatkan kualitas dan kuantitas hasil belajar

matematika siswa SD dan SMP di seluruh Indonesia.




Kata Pengantar

Kami sangat mengharapkan masukan dari para pembaca untuk menyempurnakan
modul-modul ini, demi peningkatan mutu layanan kita dalam upaya peningkatan

mutu pendidikan matematika di Indonesia.

Akhirnya, kami ucapkan selamat membaca dan menggunakan modul ini dalam

mengelola pembelajaran matematika di sekolah.

Yogyakarta, Maret 2010
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PENDAHULUAN

A. Latar Belakang

Kemajuan teknologi komputer sekarang ini telah mempengaruhi berbagai sektor
kehidupan, tidak terkecuali dunia pendidikan. Di dalam dunia pendidikan, komputer
telah banyak dimanfaatkan untuk berbagai hal, baik untuk urusan administrasi
maupun untuk mendukung kegiatan pembelajaran. Dalam pembelajaran misalnya,
komputer telah banyak digunakan untuk proses pembelajaran yang interaktif, untuk
mendapatkan berbagai informasi melalui sambungan Internet, dan untuk penyiapan

bahan ajar.

Hal tersebut sejalan dengan tuntutan pendidikan itu sendiri sebagaimana diamanatkan
dalam Undang-Undang Sistem Pendidikan Nasional (UU nomor 20 tahun 2003) dan
Peraturan Pemerintah Republik Indonesia Nomor 19 tahun 2005 tentang Standar
Nasional Pendidikan. Sebagaimana disebutkan dalam Panduan Penyusunan
Kurikulum Tingkat Satuan Pendidikan Jenjang Dasar dan Menengah dari BSNP
tahun 2006, bahwa “Pendidikan harus terus-menerus melakukan adaptasi dan
penyesuaian terhadap perkembangan IPTEKS sehingga tetap relevan dan kontekstual
dengan perubahan. Oleh karena itu, kurikulum harus dikembangkan secara berkala
dan berkesinambungan sejalan dengan perkembangan ilmu pengetahuan, teknologi

dan seni.”

Di dalam Permendiknas No. 22/2006, pada daftar Standar Kompetensi (SK) dan
Standar Isi Mata Pelajaran Matematika SMP juga disebutkan bahwa “Untuk
meningkatkan keefektifan pembelajaran, sekolah diharapkan menggunakan teknologi

informasi dan komunikasi seperti komputer, alat peraga, atau media lainnya.”

Untuk mendukung pembelajaran sebagaimana yang diharapkan di atas terutama
untuk penyiapan naskah matematika, guru dapat memanfaatkan berbagai program
aplikasi komputer yang selama ini mungkin telah dikenal seperti MS Word. Program

ini dapat membantu guru untuk menyiapkan bahan ajar dan RPP maupun untuk

mendukung proses pembelajaran matematika. MS Word menyediakan fasilitas yang
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dapat digunakan untuk menuliskan simbol-simbol, notasi dan ekspresi matematika
serta membuat gambar bangun-bangun matematika (titik, garis, bangun-bangun datar,
bangun ruang, kurva, dan lain-lain) yang sering diperlukan di dalam naskah-naskah
yang akan disiapkan oleh guru matematika. Fasilitas MS Word yang dapat

dimanfaatkan untuk tujuan tersebut adalah Symbol, Equation, dan Drawing.

Pada kenyataannya, melalui berbagai diklat yang diadakan oleh P4ATK Matematika
diketahui masih banyak guru SMP yang belum dapat memanfaatkan komputer untuk
pembelajaran secara optimal, termasuk memanfaatkan fasilitas Symbol, Equation,
dan Drawing tersebut untuk menyiapkan naskah/bahan ajar matematika. Selain itu
juga ditemukan banyak naskah matematika, bahkan beberapa Buku Sekolah
Elektronik, yang memuat beberapa kejanggalan dalam menampilkan suatu ekspresi

matematika.

Berdasarkan hal-hal yang diungkapan di atas, perlu adanya suatu panduan yang dapat
dimanfaatkan oleh guru untuk menulis naskah/bahan ajar matematika SMP secara
lebih baik dengan memanfaatkan fasilitas Symbol, Equation, dan Drawing pada
program pengolah kata MS Word. Panduan ini disusun dalam bentuk modul yang
dapat dimanfaatkan untuk belajar secara mandiri maupun bersama pada kegiatan

MGMP.

Kedudukan modul ini dalam program BERMUTU adalah sebagai suplemen lanjutan
untuk Bahan Belajar Mandiri (BBM) ICT yang telah disusun pada tahun 2008, dan
suplemen untuk modul Pemanfaatan Komputer sebagai Media Pembelajaran

Matematika di SMP yang telah dikembangkan tahun 2009.

B. Tujuan

Modul ini dimaksudkan sebagai panduan belajar tambahan (suplemen) yang dapat
digunakan oleh guru matematika SMP maupun guru-guru lain yang ingin
menggunakan program MS Word untuk menyiapkan naskah/bahan ajar dan perangkat

pembelajaran lain dengan menfaatkan fasilitas yang ada di dalamnya, khususnya

fasilitas Symbol, Equation, dan Drawing, secara optimal.




Penggunaan Program Pengolah Kata untuk Penyiapan Bahan Ajar Matematika SMP: Symbol, Equation, Drawing

C. Peta Kompetensi

Modul ini disusun untuk mendukung peningkatan kompetensi guru seperti yang

diharapkan pada Permendiknas nomor 16 tahun 2007, khususnya:

1. kompetensi pedagogik guru yaitu memanfaatkan teknologi informasi dan
komunikasi untuk kepentingan pembelajaran, dan

2. kompetensi profesional butir 20, yaitu menguasai materi, struktur, konsep, dan
pola pikir keilmuan yang mendukung mata pelajaran yang diampu.

3. Pada penjabaran kompetensi ini tercantum salah satu kompetensi guru
matematika adalah mampu menggunakan alat peraga, alat ukur, alat hitung,

piranti lunak komputer, model matematika, dan model statistika.

Secara lebih khusus, modul ini juga akan mendukung peningkatan kompetensi guru

yang terkait dengan pemanfaatan komputer, yakni:

1. menggunakan fasilitas Symbol pada MS Word untuk menuliskan simbol-simbol
dan notasi matematika secara benar di dalam naskah,

2. menggunakan fasilitas Equation pada MS Word untuk menuliskan ekspresi-
ekspresi matematika (termasuk persamaan, pertidaksamaan) secara benar di
dalam naskah, dan

3. menggunakan fasilitas Drawing pada MS Word untuk membuat gambar bangun-

bangun geometri secara baik di dalam naskah.

D. Ruang Lingkup

Panduan ini terdiri atas 3 (tiga) modul. Pada modul 1 dibahas bagaimana cara
menuliskan lambang-lambang dan notasi matematika secara benar dengan
menggunakan fasilitas Symbol pada MS Word. Hal-hal yang akan Anda pelajari
modul 1 meliputi langkah-langkah menyisipkan simbol pada naskah matematika,
mendefinisikan tombol cepat (shortcut) untuk mempersingkat suatu perintah, dan
beberapa tips untuk memperbaiki penampilan naskah. Pada modul 2 dibahas bagai-
mana cara menuliskan ekspresi-ekspresi matematis secara baik dan benar dengan
menggunakan Microsoft Equation 3.0 dan Equation versi 2007. Hal-hal yang akan

Anda pelajari pada modul 2 meliputi cara menuliskan ekspresi matematika,

mendefinisikan tombol cepat (shortcut), pengaturan ulang berbagai simbol, font, dan
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spasi, serta beberapa trik (pada contoh kasus) untuk memperbaiki tampilan. Pada
modul 3 dibahas bagaimana cara membuat gambar bangun-bangun geometri dengan
menggunakan fasilitas Drawing pada MS Word. Pembahasan meliputi pengenalan

fasilitas Drawing dan teknik-teknik menggambar.

Modul ini disusun dengan mengasumsikan bahwa para guru saat ini biasanya
menggunakan MS Word versi 2003 atau versi 2007. Oleh karena itu, isi panduan
yang diuraikan di dalam modul-modul tersebut berorientasi pada MS Word 2003 dan
MS Word 2007.

E. Saran Cara Penggunaan Modul ini di MGMP/Sekolah

1. Sebelum mempelajari modul ini guru diharapkan sudah menguasai BBM ICT

2. Modul ini dapat digunakan oleh guru anggota MGMP secara individu maupun
kelompok.

3. Sangat disarankan ketika menggunakan modul ini untuk belajar mandiri maupun
secara berkelompok, guru langsung menggunakan komputer (desktop/laptop) dan
langsung mempraktikan contoh-contoh atau langkah-langkah yang dituntunkan.

4. Untuk mempelajari sekaligus mempraktikkan modul ini dibutuhkan waktu sekitar
18 jam belajar (1 jam belajar =50 menit), dengan alokasi waktu sebagai berikut:

Empat (4) jam untuk mempelajari Modul 1 (penggunaan fasilitas Symbol),
b. Tujuh (7) jam untuk mempelajari Modul 2 (penggunaan Microsoft
Equation 3.0 dan Equation 2007),
c. Tujuh (7) jam untuk mempelajari Modul 3 (penggunaan fasilitas Drawing).

5. Alternatif proses belajarnya yang disarankan adalah sebagai berikut:

a. Mulailah membaca dari bagian pendahuluan untuk mengetahui harapan dan
target dari belajar modul ini.

b. Masing-masing modul berdiri sendiri, sehingga untuk mempelajari modul 3
ataupun modul 2 tidak harus mempelajari modul 1 terlebih dahulu.

Meskipun demikian, Anda diharapkan mempelajarinya secara urut dimulai

dari modul 1 (dari yang paling sederhana).
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c. Pada saat mempelajari masing-masing modul, mulailah membaca dari
bagian awal untuk mengetahui manfaat masing-masing fasilitas yang akan
dibahas di bagian selanjutnya.

d. Pada saat mempelajari pemanfaatan masing-masing fasilitas (Symbol,
Equation dan Drawing), akan lebih efektif jika Ada langsung mempraktik-
kan dengan komputer.

e. Setelah Anda merasa cukup menguasai materi, kerjakan latihan pada setiap
akhir modul untuk mengecek pemahaman Anda terhadap materi yang telah
dipelajari.

f. Pada bagian akhir terdapat tugas untuk mengukur pemahaman Anda
terhadap isi seluruh modul. Setelah Anda selesai mempelajari semua modul,
kerjakan tugas akhir tersebut.

6. Agar efektif dalam mempelajari modul ini hendaknya masing-masing guru
anggota MGMP menggunakan satu komputer.

7. Apabila masih perlu melakukan klarifikasi terhadap isi modul ini, berdiskusilah
dengan sesama guru seprofesi di sekolah atau MGMP, atau berkonsultasi dengan
narasumber misalnya kepala sekolah, pengawas, atau instruktur/guru inti di
tempat MGMP.

8. Apabila terdapat permasalahan yang perlu dibicarakan atau dikomunikasikan
lebih lanjut dengan penulis atau PATK Matematika terkait dengan isi modul ini,
silakan Anda menghubungi P4ATK Matematika melalui alamat JI. Kaliurang Km 6
Condongcatur, Depok, Sleman, Yogyakarta 55281, telepon (0274) 881717,
885725, 885752, Kotak Pos 31 Yk-Bs, atau dikirim lewat faksimili (0274)
885752 atau e-mail: p4tkmatematika@yahoo.com. Anda juga dapat menghubungi
penulis dengan alamat e-mail ontongts@yahoo.com atau

joko purnomo_01@yahoo.com.

Selamat belajar, semoga berhasil!
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MODUL 1
MENYISIPKAN SIMBOL MATEMATIKA
PADA NASKAH MS WORD

Ketika menulis naskah matematika dengan menggunakan MS Word, Anda sering
menggunakan karakter-karakter atau simbol-simbol yang tidak terdapat pada papan
ketik (keyboard), seperti #, a, B, &, A, ¢, O, V. Lantas bagaimana caranya menuliskan
simbol-simbol tersebut dengan MS Word? Mungkin sebagian di antara Anda sudah
tahu, namun beberapa mungkin belum terbiasa menuliskan simbol-simbol tersebut

dengan menggunakan fasilitas Insert Symbol pada MS Word.

Mengapa harus menggunakan Insert Symbol? Perlu Anda ketahui bahwa pada
komputer terdapat dua jenis karakter yang dituliskan, yaitu karakter yang berbasis
ANSI (American National Standard Institute) dan non-ANSI. Karakter ANSI dapat
langsung dihasilkan dengan menggunakan sebuah tombol atau kombinasi (memencet
beberapa tombol secara bersamaan) pada papan ketik (keyboard). Karakter non-ANSI
termasuk di dalamnya berbagai macam simbol tidak dapat langsung dihasilkan
dengan menggunakan tombol-tombol pada papan ketik, untuk menuliskannya Anda

perlu menggunakan fasilitas Insert Symbol pada MS Word.

Contoh sederhana untuk menunjukkan perbedaan lambang matematika yang diketik
dengan tombol keyboard dan yang dihasilkan dengan menggunakan fasilitas Insert
Symbol adalah tanda plus (+). Ketika seluruh teks diblok dan jenis hurufnya diubah,
maka tanda plus yang diketik melalui keyboard mungkin akan berubah bentuknya.
Sementara itu, dengan perlakuan sama, tanda plus (+) yang dihasilkan dari fasilitas
Insert Symbol tidak berubah bentuknya. Semua simbol atau karakter yang
dimasukkan melalui fasilitas Insert Symbol diproteksi oleh Windows terhadap

perubahan format teks.

Perhatikan contoh pengetikan naskah pada yang diambil pada salah satu Buku
Sekolah Elektronik kelas VII berikut.
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a. 33=3x3x3 dan32=3x3 |
3°x32=(3x3x3)x(3x3)

Gambar 1.1

Jadi, 5 - 2 = 3. Artinya beda suhu kedua lemari es adalah
3°C. Periksa 5 + (-2) menggunakan garis bilangan dan keping
aljabar . Banding hasilnya dengan hasil dari 5 - 2.

Gambar 1.2

Perhatikan contoh kasus pada Gambar 1.1 terdapat dua lambang operasi perkalian
yang berbeda (yakni ' X' dan 'x') . Sementara itu, pada Gambar 1.2 terdapat dua
lambang operasi pengurangan yang berbeda ( '—' dan '-' ) dan penggunaan angka 0
(nol) pada posisi superscript (posisi sedikit di atas baris) sebagai lambang satuan
derajat. Kasus di atas merupakan contoh kesalahan yang sering terjadi pada
pengetikan naskah-naskah matematika. Kesalahan yang lain di antaranya seperti

terlihat pada tabel berikut.

Tabel 2.1

Wajar | Tidak Wajar Kesalahan yang terjadi

x+y Xty Menggunakan huruf tegak sebagai variabel.

3-2 3-2 Menggunakan hypen (untuk memenggal kata) bukan
tanda minus (en-dash).

a-b a.b Menggunakan titik untuk mengakhiri kalimat sebagai
perkalian, seharusnya gunakan midle dot.

3x2 3x2 Menggunakan huruf x sebagai simbol perkalian.

30° 30°, 30° Menggunakan huruf o non kapital atau nol (0)

kemudian di-superscript. Seharusnya menggunakan
simbol derajat.

Fasilitas Insert Symbol yang terdapat pada MS Word 2007 relatif sama dengan yang
terdapat pada MS Word 2003. Pada versi 2007 untuk menuliskan simbol dilakukan

dengan mengklik I m"“], pada ribbon klik w. Salah satu keunggulan
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pada MS Word 2007 untuk keperluan naskah matematika adalah tersedianya fasilitas
Math AutoCorrect. Fasilitas ini memudahkan Anda menuliskan simbol-simbol
matematika melalui papan keyboard. Terdapat lebih dari 200 simbol yang dapat

disisipkan pada naskah melalui fasilitas ini.

Setelah mempelajari modul ini Anda diharapkan mampu menyisipkan simbol secara
benar ke dalam naskah, menampilkan ikon Insert Symbol pada layar MS Word
2003, membuat shortcut Insert Symbol, Autocorrect, dan Math Autocorrect pada
layar MS Word 2007.

Modul ini terdiri atas dua kegiatan belajar. Pada kegiatan belajar pertama Anda akan
belajar bagaimana menyisipkan simbol-simbol khusus ketika Anda bekerja dengan
MS Word 2003. Pada kegiatan belajar kedua Anda akan belajar melakukan hal sama

namun dengan asumsi Anda bekerja menggunakan MS Word 2007.

A. Kegiatan Belajar 1: Menggunakan Simbol pada MS Word 2003

1. Menyisipkan simbol ke dalam teks

Berikut ini langkah-langkah untuk menyisipkan simbol/karakter ke dalam suatu

naskah.

Letakkan kursor pada posisi di mana simbol akan ditampilkan.

b. Klik Insert pada baris menu kemudian klik submenu Symbol. Sebuah jendela
(kotak dialog) Symbol akan muncul seperti pada Gambar 1.3.

c. Pilih simbol yang diinginkan. Anda mungkin perlu memilih jenis font, menggeser
scroll bar vertikal, atau memilih 7ab Special Characters jika simbol yang Anda
inginkan belum terlihat pada kotak dialog Symbol.

d. Klik dobel simbol atau karakter yang Anda inginkan, atau klik sekali kemudian
klik tombol Insert. Anda dapat juga memanfaatkan simbol pada Recently used
symbol untuk memilih simbol-simbol yang terakhir atau sering digunakan.

e. Jika Anda ingin menyisipkan simbol yang lain, letakkan kursor pada posisi yang

diinginkan, kemudian ulangi langkah 4. Anda dapat berpindah dari kotak dialog
Symbol ke naskah dengan menekan tombol + (tekan dan tahan

tombol kemudian tekan tombol sekali dan lepaskan keduanya).
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f.  Setelah selesai menyisipkan simbol, klik Close.
g. Jika Anda membatalkan menyisipkan simbol, tetapi terlanjur masuk ke kotak

dialog Symbol, tekan tombol , atau klik Cancel.

: x]
NSER@@GBQUDQ(ZCQGEH
Z|v|®|e|™|V|. |-|A|vielc o] U
ol(|@le[™|z| ([ [\ {L{M$]L]
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Alolelefelelx]>] <ol L[] [+]a]
Symbol: 199 Gharacter code: 199 | from: | Symbol (decimal) &l

W= )
Gambar 1.3 Kotak dialog Symbol

Sekarang cobalah Anda menyisipkan simbol-simbol #, a, B, T, A, ¢, ©, V. Lakukan!

2. Menggunakan pangkat (superscript) dan indek (subscript)

Fasilitas format superscript dan subscript digunakan untuk menempatkan suatu
karakter sedikit di atas (pangkat) atau di bawah (indek) posisi karakter yang normal.
Sebagai contoh angka 2 digunakan sebagai pangkat pada "y =x>", dan sebagai indek
pada "x, = 6". Perhatikan bahwa karakter yang digunakan sebagai superscript dan

subscript memiliki ukuran font yang lebih kecil daripada karakter normalnya.

Terdapat berbagai cara untuk menggunakan teks sebagai pangkat atau indek, di

antaranya seperti yang dijelaskan berikut ini.

Cara 1: Blok karakter/teks yang akan dijadikan pangkat atau indek, kemudian klik

kanan pada teks yang diblok, selanjutnya klik Font (A Font... )
sehingga muncul kotak dlalog Font. Pada bagian Effect, centang pilihan

Superscript (

dengan mengklik tombol OK (E).
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Contoh: untuk menuliskan basis”*  ketik "basispangkat", blok tulisan
"pangkat", klik kanan, pilih Font, centang pilihan Superscript. Untuk
menuliskan variabeljqek, ketik "variabelindek", blok tulisan "indek", klik

kanan, pilih Font, centang pilihan Subscript.

Cara 2: Blok karakter/teks yang akan dijadikan pangkat atau indek, kemudian tekan

untuk menjadikan indek, atau tekan ++|E| untuk

menjadikan pangkat. Cobalah contoh di atas dengan cara ini!

Cara 3: Untuk menulis teks yang dimulai dengan subscript tekan =|. Kursor
berubah lebih pendek. Teks yang Anda ketik akan tercetak lebih kecil dan
agak turun ke bawah. Untuk kembali ke pengetikan normal, tekan

= sekali lagi. Demikian juga untuk superscript, sebelum dan

sesudah menulis dalam bentuk superscript, tekan +|E|.

Cobalah!

Catatan:

Kombinasi +|E| dan +|E| berturut-turut merupakan shortcut

untuk subscript dan superscript.

3. Menampilkan ikon Insert Symbol pada baris ikon (toolbar)
Langkah klik Insert dilanjutkan dengan klik Symbol untuk memunculkan kotak

dialog Symbol dapat dipercepat dengan mengklik ikon £2 pada baris ikon. Apabila
ikon ini belum tampak pada baris ikon, maka untuk memunculkannya klik Tools pada
baris menu, kemudian klik Customize pada submenu yang muncul, klik fab

Command, pada kotak Categories pilih Insert, pada kotak Command, geser scroll

bar vertikal dan temukan S Symbol... ‘ Drag dan drop (tarik dan letakkan)

Symbol ( £2) ke baris ikon. Ikon &2 akan muncul di sana. Lihat Gambar 1.4.
Cobalah!
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Gambar 1.4 Jendela Customize pada MS Word

4.  Membuat perintah Insert Symbol melalui keyboard

Untuk menuliskan simbol, selain dengan dua cara di atas, Anda dapat membuat

shortcut dengan langkah: (1) klik Tools pada baris menu, (2) klik Customize, (3) klik

ot sehingga muncul kotak dialog Customize Keyboard (lihat Gambar
1.5), (4) pada daftar Categories pilih Insert, pada daftar Command pilih
InsertSymbol, pada kotak teks Press new shortcut key, isikan dengan menekan

tombol (tekan dan tahan tombol , tekan tombol kemudian lepaskan

keduanya).

Anda dapat memilih tombol apa saja pada keyboard, dalam contoh ini digunakan
tombol . Pastikan kombinasi shortcut ini belum digunakan dengan melihat pada
“Currently assigned to:” muncul pesan “[unassigned]”. Jika ternyata shortcut telah
digunakan untuk perintah lain dan Anda tetap memaksakan, maka target shortcut
lama terhapus dan digantikan target shortcut yang Anda definisikan sekarang.
Langkah berikutnya adalah (5) tekan tombol Assign dan klik Close pada jendela
Customize Keyboard, dan terakhir (6) klik Close pada jendela Customize.

Selanjutnya Anda dapat memunculkan jendela Insert Symbol dengan menekan

[Alt]]s]




Penggunaan Program Pengolah Kata untuk Penyiapan Bahan Ajar Matematika SMP: Symbol, Equation, Drawing

Customize Keyboard X

Specify a command

Categories: Commands:
InsertSoundC
InsertSymbol

InsertTableOfAuthorities

<mm
§gd
uu|‘)

InsertTableOfContents
Format InsertTableOfFigures =)
Tools InsertTimeField
Table [9 InsertVerticalFrame B
Specify keyboard sequence
Current keys: Press new shortcut key:
A IAI:+S| I

v

Currently assigned to: [unassigned]
Saye changes in: | Mormal !ZI
Description

Inserts a special character R

Gambar 1.5 Jendela Customize Keyboard

5.  AutoCorrect dan pembuatan shortcut

MS Word mempunyai kemampuan mengubah atau membetulkan rangkaian karakter
yang Anda ketik menjadi tulisan atau simbol tertentu sesuai dengan kombinasi atau
rangkaian karakter yang baru saja Anda tulis. Contohnya, ketika Anda mengetik "(",
"c", ")" berturut-turut kemudian Anda menekan tombol spasi, Word akan otomatis
mengubah rangkaian ketiga karakter tersebut menjadi lambang hak cipta ©.

Kemampuan mengubah tulisan seperti ini disebut kemampuan autocorrect pada MS
Word.

Cobalah Anda lakukan sebagai berikut:

Tekan tombol-tombol , ,El, , . Apa yang terjadi? Anda akan

mendapatkan hasil "3 — 2". Secara otomatis biasanya Word akan mengubah tanda "-"

menjadi "-" (perhatikan panjang kedua tanda tersebut berbeda). Bandingkan dengan

apabila Anda mengetik , E|, (antara "-" dan "2" tidak ada spasi).

Jika Anda sering menggunakan simbol yang sama berulang-ulang, Anda dapat

membuat shortcut atau memanfaatkan fasilitas AutoCorrect untuk mempercepat
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pekerjaan. Sebagai contoh, berikut ini langkah-langkah untuk membuat penggantian

otomatis untuk o.

a. Munculkan kotak dialog Symbol seperti pada Gambar 1.3

b. Klik simbol a. Anda mungkin perlu mengganti daftar Font, atau menggeser
scroll bar untuk menemukan simbol a.

c. Klik AutoCorrect. Pada kotak teks Replace, ketikan "*alpha" (tanpa tanda petik)

d. Klik Add (Eadd )

e. Klik OK.

Sekarang cobalah Anda mengetik "*alpha" diikuti spasi. Secara otomatis teks tersebut

akan diganti dengan a.

Diperlukan kehati-hatian dalam menentukan kata untuk fasilitas AutoCorrect.
Usahakan untuk menggunakan kata yang tidak pernah digunakan untuk menghindari

penggantian yang tidak diinginkan.

Cara lain untuk mempercepat penulisan simbol adalah dengan membuat shortcut.

Berikut ini contoh membuat shortcut untuk simbol perkalian (x).

a. Munculkan kotak dialog Symbol (Gambar 1.3).
b. Klik simbol x. Anda mungkin perlu mengganti jenis Font dan menggeser scrol/

bar vertikal untuk menemukan simbol x.

c. Klik Shortcut Key (W). Pindahkan kursor pada kotak teks Press
New Shortcut Keys, kemudian tekan +.

d. Klik Assign.
e. Klik Close.

Pastikan kombinasi tombol yang Anda gunakan sebagai shortcut belum digunakan

untuk perintah lain. Sebagai contoh jika pada langkah di atas Anda menggunakan

tombol , (bukan di jendela Customize Keyboard pada

Currently Assigned to terlihat keterangan EditCut. Ini menunjukkan bahwa

kombinasi tombol tersebut telah dipakai untuk fasilitas Edit Cut. Jika Anda
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memaksakan tetap menggunakan kombinasi ini, maka shortcut bawaan Windows

tersebut akan digantikan oleh shortcut yang Anda buat terakhir.

Catatan:

Anda dapat melihat shortcut yang telah ada dengan cara:

a. Klik Tools pada baris menu.

b. Klik Macro pada daftar submenu.

c. Klik Macro pada sub-submenu.

d. Pada jendela Macro yang muncul, di Macros in, pilih Word commands,
dalam daftar di atasnya geser scroll bar, dan pilih ListCommands.

e. Klik Run. Pada jendela pilih current menu and keyboard settings.

f. Klik OK.

Meskipun tidak ada ketentuan khusus dalam memilih kombinasi tombol untuk

shortcut, sebaiknya Anda menggunakan tombol [Alt| bukan . Hal ini
dikarenakan sebagian besar kombinasi yang menggunakan dan beserta karakter
lain telah digunakan oleh MS Word. Sebagai contoh | a | untuk perintah Select

All, b| untuk perintah Bold, + untuk perintah Edit - Copy, dan

sebagainya. Selain itu, kombinasi huruf yang dipakai hendaknya menyesuaikan

fungsi atau lambang yang diinginkan agar mudah diingat. Misalnya, + untuk

“1”, dan sebagainya.

6. Non Breaking Space
Perhatikan dua naskah yang diambil dari Buku Sekolah Elektronik (BSE) berikut:

4.  Berfikir Kritis. Tentukan nilai a sehingga pertidaksamaan ax +
4 <-12 mempunyai penyelesaian seperti gambar di bawah ini.

1. Gunakanlah model ubin aljabar untuk mm}rederhanakan i
+5 + Sy— 4,

Pada dua contoh di atas terdapat penulisan ekspresi matematika yang tidak nyaman

untuk dilihat karena terpotong. Dalam naskah matematika umumnya terdapat spasi
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antara suku-suku suatu ekspresi matematika. Jika spasi tersebut dimasukkan hanya
dengan menekan batang spasi (spacebar), maka ketika ekspresi matematika tersebut
melampaui batas kiri halaman, ia akan terpotong pada spasinya. Hal ini dapat diatasi

dengan menggunakan Non Breaking Space, yaitu dengan menekan tiga tombol

(| Ctrl [H{ Shift | spasi |) sekaligus ketika membuat spasi.

Tampilan ekspresi matematika pada contoh pertama di atas dapat diperbaiki dengan

urutan penulisan sebagai berikut:

[a], [x], [Ctrt |+ Shift }t{Ispasi], [+], [Cerl |} Shift [ spasi], [4], [Ctrl ] Shift [ spasi] ,
<, |Ctrl |+ Shift | spasi |, —, [ 1], .

Catatan:

Gunakan tanda +, —, < melalui fasilitas Insert Symbol.

B. Kegiatan Belajar 2: Menggunakan Simbol pada MS Word 2007

1. Langkah-langkah menyisipkan simbol pada MS Word 2007
Untuk memunculkan jendela Symbol, klik Insert pada baris menu, kemudian klik

M, sehingga muncul jendela Symbol seperti berikut ini (Gambar 1.6a).

.1v#3%&a()*+,—./012!§|
314(5(6(7(8[9:[:[<|=|>|?|=z|A|B|X|A|E
l OITHII|S|KIAIMN|OITT|®|P|Z|T|Y|g|Q|E
VAT -
sl L s T o|Bly(dlsld|y(n[r|e]|K
P A m P
a ¢ 1 € g||vulsld] [
Symbol: 32 | T Symbol (decimal) ||
¥ 0 ° ™ 3| (ancwe ] [Sutarier.] sttty
€2 More Symbols... (g J [ concel | )
(@) (b)

Gambar 1.6. Jendela Symbol pada MS Word 2007
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Simbol-simbol yang terdapat pada bagian atas merupakan simbol-simbol yang

terakhir digunakan. Jika simbol yang Anda inginkan tidak terlihat, Anda dapat

mengklik $2 _ More Symbols... pada bagian bawah jendela tersebut sehingga muncul

tampilan seperti pada Gambar 1.6b.

Anda tinggal memilih simbol yang Anda inginkan. Langkah-langkahnya seperti pada
Word 2003.

2. Menggunakan Fasilitas Math AutoCorrect

Fasilitas Math AutoCorrect memberikan cara mudah untuk menuliskan simbol-
simbol matematika, tanpa harus menggunakan menu Insert Symbol. Sebagai contoh,
Anda cukup mengetik ‘““\angle” untuk menuliskan simbol sudut “2”. Jika Anda
mengetik ‘“\alpha”, MS Word akan mengubahnya menjadi tulisan simbol “a”. Untuk
melihat daftar kata-kata yang akan dikoreksi otomatis buka kotak dialog Symbol

seperti Gambar 1.6b, kemudian klik AutoCorrect (L2ZEESTE:

| AutoCorrect | Math Autocorrect |

[¥] Use Math AutoCorrect rulés outside of math regions

When Math AutoCorrect and AutoCorrect rules conflict, AutoCorrect rules will
be used.

AutoCorrect.

) izl
Gambar 1.7 Jendela Autocorrect pada MS Word 2007
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Catatan:

Agar fungsi Math AutoCorrect dapat bekerja, mungkin Anda harus mengatur
ulang kotak dialog di atas dengan memberi tanda contreng (\) pada fab
AutoCorrect bagian Replace text as you type. Demikian pula pada fab Math
AutoCorrect, beri centang pada Use Math AutoCorrect runs outside of

math regions, dan Replace text as you type.

3. Membuat shortcut untuk Insert Symbol

Klik tombol MS Office @ kemudian klik Word Options dan Customize. Di

bagian bawah jendela yang muncul klik mize: | sehingga muncul jendela
Customize Keyboard (Gambar 1.8). Pada daftar Categories pilih All Commands;
pada daftar Commands pilih InsertSymbol; pada kotak teks Press new shortcut
key isikan dengan menekan kombinasi tombol (misalnya ) yang akan dipakai

sebagai shortcut, kemudian klik Assign dan terakhir klik Close.

Catatan:
Pastikan kombinasi shortcut belum digunakan.

Customize Keyboard

Specify a command
Categories: C
Print Preview Tab [ | InsertSoundComment [a]
Tab InsertSpike
Ig %_ InsertStyleSeparator
InsertSubdocument
Macros sertSymbo
AutoText ~ |InsertTableOfContents E
Styles ¥ |InsertTableofC [w)
Specify keyboard sequence
Current keys: Press new shortcut key:
o |aies |
Currently assigned to: [unassigned]
B
Description
Inserts a special character

Gambar 1.8 Jendela Customize Keyboard pada MS Word 2007
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C. Ringkasan

Insert Symbol di dalam Microsoft Word merupakan fasilitas yang dapat digunakan
untuk menyisipkan simbol dan karakter yang tidak terdapat pada papan ketik
(keyboard). Karakter yang dituliskan melalui fasilitas Insert Symbol tidak akan
berubah meskipun format teks diubah. Untuk menyisipkan simbol atau karakter,
dapat dilakukan melalui baris menu (Insert > Symbol), shortcut, AutoCorrect atau
Math AutoCorrect (pada MS Word 2007). Anda dapat membuat berbagai shortcut
untuk mempercepat pekerjaan. Dalam pembuatan shortcut harus diperhatikan bahwa
kombinasi tombol yang akan diinginkan belum digunakan untuk perintah lain, atau

apabila sudah digunakan perintah tersebut tidak banyak dirasakan manfaatnya.

D. Latihan

1. Jelaskan salah satu keuntungan menuliskan simbol melalui fasilitas Insert
Symbol.
2. Buatlah fasilitas AutoCorrect untuk simbol c.
3. Buatlah shortcut untuk simbol €.
4. Jelaskan langkah-langkah agar suatu ekspresi matematika tidak terpotong ketika
melampaui tepi paragraf.
5. Ketik teks berikut:
a. ANnB={x|x€Adanx€B}
b. JikndcBmakad "B=A4
Ukurlah 24BC, £BCA, £PQR dan £BCD
d. 4£80T =(x+28)°

e

e. L=m"

f. AEFA=AEBC

Anda telah mempelajari seluk-beluk fasilitas yang dapat digunakan untuk menuliskan
simbol-simbol khusus pada Microsoft Word, mempraktikkan beberapa contoh, dan

mencoba latihan yang diberikan. Anda dianggap berhasil jika dapat mengerjakan

minimal 75% dari soal latihan. Bagi Anda yang sudah berhasil, dapat melanjutkan ke
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modul berikutnya dan membantu rekan-rekan yang masih mengalami kesulitan. Bagi
Anda yang belum dapat mencapai target 75%, ada baiknya untuk membaca ulang,

bertanya dan berdiskusi dengan rekan-rekan Anda.

E. Umpan Balik

Untuk soal no. 1, Anda dapat membaca penjelasan di awal modul, di samping Anda
mencoba mengeksplorasi sendiri kelebihan fasilitas tersebut. Pada soal no. 2 dan 3,
Anda dapat melakukan dengan membuka jendela Insert Symbol. Gunakan kata atau
kombinasi karakter yang jarang digunakan, namun mudah diingat. Untuk soal nomor

4, agar suatu ekspresi matematika tidak terpotong ketika melampaui tepi paragraf

maka ketika memberikan suatu spasi tekan kombinasi tombol | Ctrl [ Shift [+ spasi |

Pada soal nomor 5, perhatikan kelaziman dalam menulis ekspresi matematika.
Sebagai contoh gunakan font Italic untuk variabel, notasi himpunan, notasi titik.
Gunakan non-Italic untuk simbol-simbol seperti irisan, himpunan bagian, sudut,

notasi segitiga, dan notasi derajat.

Ketika Anda telah mempelajari modul ini secara tuntas, Anda berarti sudah mampu

melakukan aktivitas-aktivitas:

1. menyisipkan simbol-simbol khusus ke dalam naskah yang Anda ketik,

2. memunculkan ikon &‘ pada toolbar (Word 2003),

3. memilih karakter apa yang seharusnya menggunakan simbol dan tidak
menggunakan simbol,

4. membuat shortcut untuk memunculkan kotak dialog Symbol,

5. menggunakan fasilitas Auto Correct dan Math AutoCorrect, dan

6. membuat shortcut untuk simbol-simbol yang sering digunakan.

Meskipun demikian, sejauh ini Anda mungkin masih kesulitan untuk menuliskan

persamaan-persamaan atau ekspresi-ekspresi matematika yang lebih rumit. Anda

akan mempelajarinya pada Modul 2.
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MODUL 2
MENULISKAN EKSPRESI MATEMATIKA
DENGAN MS EQUATION

Meskipun sudah tersedia fasilitas Insert Symbol yang dapat digunakan untuk
menuliskan berbagai macam simbol matematika, namun fasilitas tersebut masih

belum cukup untuk menuliskan ekspresi matematika yang lebih rumit seperti

_ +nyx, + L +nx,

Feab n,+n,+L +n

Fasilitas untuk menuliskan ekspresi matematika yang lebih lengkap terdapat dalam
Equation Editor, yang pada MS Word 2003 memiliki nama Microsoft Equation
3.0 (terdapat juga pada MS Word 2007), dan pada MS Word 2007 memiliki nama
Equation. Untuk membedakannya, dalam modul ini nama Equation 3.0 digunakan
untuk Microsoft Equation 3.0 dan Equation 2007 untuk Equation di MS Word
2007. Dengan menggunakan fasilitas tersebut, penulisan ekspresi matematika yang

rumit menjadi lebih mudah dilakukan.

Tampilan menu pada Equation 3.0 dan menu Equation 2007 memiliki perbedaan
yang menyolok. Meskipun pada modul ini dibahas penggunaan Equation 2007,
namun penckanannya lebih pada Equation 3.0 dengan pertimbangan bahwa
Equation 3.0 terdapat pada kedua versi MS Word dan adanya kelemahan bahwa
ekspresi yang dihasilkan oleh Equation 2007 tidak dapat diedit di MS Word 2003

(akan diubah menjadi gambar).

Setelah mempelajari modul ini Anda diharapkan mampu menyisipkan ekspresi
matematika melalui fasilitas Equation, membuat shortcut untuk Equation,
mengubah style (pada Equation 3.0), membuat style sendiri, mengatur ulang ukuran,
menggeser posisi elemen. Dalam modul ini banyak dibahas tentang shortcut untuk
menuliskan simbol dan template. Penggunaan shortcut ini bukan kebutuhan mutlak,

akan tetapi akan mempercepat proses pengetikan suatu ekspresi matematika

dibandingkan dengan menggunakan mouse.
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A. Kegiatan Belajar 1: Menggunakan Equation 3.0

1. Cara menggunakan Equation 3.0

Langkah-langkah untuk menyisipkan sebuah ekspresi matematika melalui Equation
3.0 adalah sebagai berikut.

Pada baris menu klik Insert, kemudian klik Object sehingga muncul jendela Object.
Pada tab Create New dan dalam daftar Object type pilih Microsoft Equation 3.0,
selanjutnya klik OK.

Pada naskah akan muncul seperti Gambar 2.1 berikut ini.

Fle Edt WView Format Style Sce Window Help

[ ---;---z-.-;-.-.-.-;-.-;---7-.-.-.-,---u---u-.-u---n-.-u-u-_

Sz= b Kil 2+@ 2=l V3 €nC ool AwbB AQ®
J1| k0 |z0gal oo Eg el R |

\ .

Gambar 2.1 Area kerja baris menu pada Equation 3.0

Anda dapat mempersingkat langkah di atas dengan mengklik ikon ¥& pada baris
ikon (toolbar). Jika ikon ini belum terlihat, Anda dapat memunculkannya dengan
langkah: (1) klik Tools, (2) klik Customize, (3) pilih tab Command, (4) pada daftar
di kotak Categories pilih Insert, (5) pada daftar di kotak Commands, tarik

Microsoft Equation dan letakkan di baris ikon. Cara ini sama dengan cara untuk

menampilkan ikon Q ke baris ikon seperti yang sudah dijelaskan pada Modul 1.

2. Bagian-bagian toolbar Equation 3.0

Pada baris atas toolbar Equation 3.0 terdapat simbol dan operator matematika yang
dapat dimasukkan ke dalam template yang terletak di baris kedua. Template ini
dilengkapi dengan simbol seperti Q, L, M dan sebagainya. Sebuah ekspresi
matematika dapat dibuat dengan merangkai template dan simbol yang sesuai ke

dalam slot (kotak yang dibatasi oleh garis titik-titik untuk diisi simbol dan operator)

pada area kerja.
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Pada masing-masing bagian foolbar Equation 3.0, jika diklik akan muncul pilihan
yang lebih detil. Sebagai contoh pada bagian simbol akar dan pecahan, jika diklik
akan muncul seperti pada Gambar 2.2. Anda tinggal memilih template yang Anda
butuhkan.

<zx | jab [ Wi§ 4@ Sol v3|EnC 3ol | AwB AQO

(n)[ﬂligmln:ﬂ SogE fudn D@ e QU |-
t
% %

Gambar 2.2

Tabel 2.1 mendaftar beberapa tombol atau kombinasi tombol yang dapat digunakan

untuk menempatkan kursor di daerah kerja Equation 3.0.

Tabel 2.1 Kombinasi tombol untuk gerakan kursor

Tombol atau Kombinasi Gerakan Kursor
Tombol

Tab ke akhir slot atau ke akhir slot berikutnya
| Shift [+ Tab | ke akhir slot sebelumnya
|1[ (panah kanan) bergerak satu karakter ke kanan dalam suatu

slot

|:[ (panah kiri) bergerak satu karakter ke kiri dalam satu slot
(panah atas) bergerak naik ke baris di atasnya
(panah bawah) bergerak turun ke baris di bawahnya
Ml bergerak ke posisi awal dalam satu slot

End bergerak ke posisi akhir dalam satu slot

Untuk mengedit ekspresi matematika yang telah diketik pada suatu naskah, Anda

cukup mengklik dua kali ekspresi tersebut.

Contoh 1

26
Berikut adalah langkah-langkah untuk menuliskan ekspresi 26:24 = 2—4.
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Buka Equation Editor: tekan , klik L D , klik _!:J, tekan @, tekan ,
tekan 2], tekan [2], Klik =% 2 ik _".J tekan [4], tekan [—], tekan [=], klik

BT ik #, tekan 2] wik % ¥ , klik _".J tekan 6], tekan [Tab], tekan
, tekan 2], Klik % 8 ik _".J tekan [ 4], klik di luar area kerja.

Cobalah Anda praktikan!

Catatan:
Pada contoh di atas Anda dapat juga menggunakan panah turun untuk

mengganti dan menggunakan mouse untuk memindahkan kursor.

Contoh 2

Misalkan Anda ingin menuliskan [% X %} - (2 X lj .

Terdapat dua cara untuk melakukannya.

Caral:

Buka Equation Editor: kiik () [ xik @ ik #~7 kik £ tekan
5], tekan [ ], tekan [6], tekan [ ], klik £ *®  klik EH dik 54T ik
%, tekan [7], tekan [ ], tekan [ 1], tekan[5], tekan [ ], tekan[—> ], tekan [—],
ek @ ki @ ik FNT ik | tekan[5] tekan [3], tekan [6],
tekan [ >, klik £¢®  Klik EJJ kik #4T ik #, tekan [1], tekan [{],

tekan , klik di luar area kerja.

Cobalah Anda praktikan!
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Cara 2: (Untuk mempercepat cara 1, gunakan fasilitas copy dan paste.)

Buka Equation Editor: kiik @) [ ik ) ik #~T kik # . tekan
[5], tekan [{], tekan [6], tekan [ ], klik £+ ®  Klik Z” kik &7 Kk
'E , tekan , tekan , tekan , tekan , tekan , tekan , blok dari

awal sampai akhir, pada baris menu klik Edit, klik Copy, tekan , tekan B,
klik Edit, klik Paste, lakukan perubahan yang diperlukan, klik di luar area kerja.

Cobalah Anda praktikan!

Catatan:

Anda dapat menekan tombol [Ctrl H c] untuk menyalin (shortcut untuk Edit,
Copy) dan menekan tombol + untuk menempelkan (shortcut untuk
Edit, Paste).

Contoh 3

Bagaimanakah cara menuliskan ekspresi berikut ini?
a" =axaxax---xa
n faktor
Buka Equation Editor: tekan[a, klik % 2, kiik %, tekan [n} tekan [=)} tekan
(=], klik :ma-ﬂ tekan [al, klik *£*® | klik EJ] blok “a x”, copy, dan paste-kan dua
kali di posisi paling belakang, klik aab. , klik =", klik ** ® , klik EJ, tekan

@, tekan , tekan , pada baris menu klik Style kemudian klik Text, tekan batang
spasi, ketik “faktor”, klik di luar area kerja. Cobalah Anda praktikan!

Catatan:
Posisi Style pada kondisi default dalam Equation 3.0 adalah Math. Perhatikan
bahwa perubahan Math Style menjadi Text Style membuat tulisan “faktor”

menjadi tegak dan memungkinkan menuliskan spasi.
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3. Membuat shortcut untuk Equation Editor
Pada baris menu klik Tool, klik Customize, pada tab Command tekan tombol

Keyboard, pada daftar Categories pilih Insert, pada daftar Command pilih
InsertEquation, pindahkan kursor ke kotak teks Press new shortcut key, tekan

+|z], klik Assign, klik Close.

Catatan:
Ketika Anda menuliskan kombinasi tombol untuk suatu shortcut, pastikan
bahwa kombinasi tombol tersebut belum digunakan. Anda dapat memastikan

kombinasi shortcut belum terpakai jika pada jendela Customize Keyboard, di

bagian “Currently assigned to:” muncul teks “[unassigned]”.

Customize Keyboard &
Specify a command
Categories: Commands:
File || | InsertDateTime ()
Edit ‘_‘ InsertDrawing 1
Tookars  Commands | Options View | | InsertEmSpace
Julookacs < . InsertEndnoteNow
To add a command to a toolbar: select a category and drag the Format InsertEnSpace
command out of this dialog box to a toolbar. Tools r InsertEquation =
Categories: Commands: Table ¥ InsertExcelTable 1)
': _J New... ) Specify keyboard sequence
View O New Ll Current keys: Press new shortcut key:
Insert Alt+2|
Format d New >
;ﬁ ) New WebPage
web New E-mail Message Currently assigned to: [unassigned]
Drawing [s] | ) New Blank Document " Saye changes in: Normal :9
Description
onge Inserts a Microsoft Equation object
Save in: | Normal v| [Eerboad...] [__Close [ WQJ [Resetal.. | [ close |

Gambar 2.3 Jendela Customize dan Customize Keyboard

4. Mengubah style

Pada contoh 3 di atas digunakan perubahan style pada Equation Editor. Selain Text
style, masih terdapat beberapa bentuk style lain yang dapat digunakan. Anda dapat
mengubah style dengan mengklik pada baris menu Equation 3.0 atau menggunakan

shortcut. Tabel 2.2 menyajikan beberapa style beserta shortcut-nya yang tersedia pada

Equation Editor.
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Tabel 2.2 Macam-macam style pada Equation Editor dan shortcut-nya

Style Shortcut Style Shortcut

Math | [Cul}{Shift}{=] | | Variable

Text [Cul{shifikle] | | Greek +
Function Matrix- b]

Vector

Dalam satu jendela Equation Editor dimungkinkan Anda menggunakan lebih dari
satu style. Untuk melihat perbedaan masing-masing s#yle, cobalah buat sebuah

persamaan berikut ini.

—b++b* —4ac

2a

X =

Selanjutnya gandakan menjadi 5 buah, untuk masing-masing cobalah mengganti
formatnya dengan berbagai format berbeda yang tersedia. Langkah berikut ini
digunakan untuk mengubah ke Text Style. Klik dobel persamaannya kemudian tekan
[Ctrl}Ha] (select all), [Ctrl [+ Shift}H e] dan terakhir klik di luar area kerja. Setelah
anda mengganti seluruh style, perhatikan perbedaannya.

—b4~/b? —4ac ~b++/b” —dac

x=—2=Y7 7% (Math Style), x= & (Text Style),
2a 2a

—_ 2— - : —
— @ (Function Style)’ x= M(Variable Style),
a a

_ 2 _b+4/b?% =
£= B w/zﬁ dax (Greek Style), x= b+ zba dac (Matrix-Vector Style).
a

Cobalah Anda praktikan!
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5.  Membuat style sendiri

Bagaimanakah jika Anda ingin mengubah jenis font yang dipakai pada Microsoft

Equation? Anda dapat membuat style sendiri dengan jenis font yang lain.

Langkah-langkahnya adalah sebagai berikut:

Buka Equation Editor: pada baris menu klik Style, klik Define, keluar tampilan

seperti gambar berikut ini.

Styles ;- _X
Style Font Character Format

Bold  Italic
Tert........ [Times NewReman (S| I
Function ... [TmesNewRoman  ~| [~ [ Cancel
Variable ... [Times New Roman _ Jid N4
LCGreek ... [Symbol = [ W
U.C Greek..... Symbol -I m =
Symbol....... Symbol 5l © ¢
MatiicVector . [TimesNewRoman  v| W [
Number .. ..... Times New Roman 2| m

Gambar 2.4 Jendela Styles pada Equation Editor

Ganti font dan atur format karakter pada bagian-bagian yang ingin diubah, kemudian
klik OK.

Contoh ekspresi matematika berikut ini menggunakan font Curlz MT pada Variable

(Sb 7 j (50’ 1)
6 15¢ 6 be

dan Number.

Cobalah Anda praktikan!

6. Mengatur ulang ukuran (size) dan spasi

Untuk merubah ukuran font dalam Equation 3.0, buka Equation Editor, klik Size,

klik Define, muncul jendela Sizes seperti Gambar 2.5.
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Subscrpt/Superscip e | |(1+B)? —
Sub- Subscript/Superscript [spt Z“:P

Symbol [1ept p=1 k Apply
Sub-spmbol [12p Defauts

Gambar 2.5 Jendela Sizes pada Equation Editor

Lakukan perubahan ukuran yang diinginkan dengan mengisi kotak teks yang tersedia.
Ketika kotak teks disorot, pada jendela bagian tengah tampak objek yang bersesuaian
diblok dengan warna hitam. Akhiri perubahan dengan menekan tombol OK. tekan

tombol Defaults jika Anda ingin mengembalikan ke bentuk yang standar.

Catatan:
Anda mungkin perlu memperbesar ukuran subscript/superscript dan sub-

superscript/ sub-subscript karena pada beberapa printer tercetak tidak jelas.

7. Menuliskan simbol melalui keyboard

Selain menggunakan mouse, beberapa simbol dapat dimasukkan dalam Equation
Editor dengan kombinasi tombol [Ctrl k], diikuti suatu karakter tertentu. Berikut

ini kombinasi tombol untuk menuliskan simbol.

Tabel 2.5 Daftar shortcut untuk menuliskan simbol

" [i]
| Shift e/

8. Menuliskan template melalui keyboard

N
[=]

\Y
NN |s [m

X

Selain simbol, Equation 3.0 juga menyediakan berbagai shortcut untuk menuliskan

template. Kombinasi tombol yang digunakan adalah karakter tertentu,

[Ctrl ], diikuti karakter tertentu.
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Tabel 2.6 Template pada Equation Editor dan shortcut-nya

Template Nama Shortcut

Parentheses (Kurung buka tutup) | [Ctrl[{9]atau[Ctrl}+{0]
Brackets (Kurung siku buka tutup) | [Ctrl [ ] atau[Ctrl 1]
Braces (Kurung kurawal buka tutup) atau
A Fraction (Pecahan) [Crl J{ £]
/ Slash Fraction (slash)
Superscript (High) CtrlHh]
Subscript (Low)

Absolute Value (Nilai Mutlak) [CtrlH t], [|] (garis tegak)
| | Root (Akar)
o7 | nth roor (Akar pangkat n) [Crl ],

Summation , E
g3 Matrix template 3x3 [Crl ],

9. Menggeser posisi elemen pada ekspresi matematika menggunakan keyboard

Posisi suatu elemen dalam Equation 3.0 dapat digeser per satu piksel. Caranya

adalah dengan memblok elemen yang akan digeser, kemudian tekan tombol

untuk menggeser ke kiri, tekan tombol untuk menggeser ke
kanan, tekan + untuk menggeser ke atas, dan untuk menggeser ke

bawabh.
Contoh 4

Misalkan Anda ingin menuliskan ekspresi pembagian bersusun sebagai berikut.
0,75

=4)3,00
2.8

El

20
50
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Contoh ini tidak dapat dibuat dengan Equation 2007 karena tidak tersedia template-

nya. Berikut ini adalah salah satu cara untuk membuat tampilan di atas. Langkah

pokok yang digunakan adalah memanfaatkan femplate E NI dan ﬁl, Text Style
di beberapa bagian, serta memblok dan menggeser elemen per satu piksel. Langkah-
langkah yang dicontohkan banyak menggunakan shortcut, namun Anda dapat
menggunakan mouse untuk memindah kursor dan memilih elemen-elemen yang

dibutuhkan pada toolbar di Equation Editor.

Buka Equation Editor:

a. tekan , tekan , tekan | V|, tekan , tekan , tekan E, tekan ,
kik BT ik @ ketikkan “3,00”, tekan [ T], ketikkan “0,75”, tekan

(kursor di akhir baris pertama, Gambar 2.6a).
b. tekan , , ketikkan “2,8”, tekan , ketikkan “20”, blok seluruh
baris kedua (Gambar 2.6b), tekan 'e| (mengubah ke Text Style,

agar teks dapat digeser menggunakan spasi), tekan panah kiri beberapa kali
sampai kursor di awal baris, +@, tekan spasi secukupnya sampai
angka 2 di bawah 3, tekan (kursor di atas garis pecahan “—* setelah angka
8), tekan spasi seperlunya untuk memperpanjang garis pecahan, tekan , tekan
B (tanda minus), blok seluruh baris kedua (Gambar 2.6¢).

c. tekan + (salin), tekan (kursor di akhir baris kedua), tekan ,
(Gambar 2.6d).

d. Pindah kursor ke baris ke-3, pada pecahan baris ini, ganti pembilang “2,8”
dengan “20” dan penyebut “20” dengan “0”. Perhatikan jarak antara baris
pertama dan kedua tidak seragam. Blok baris ke-2 dan 3 dan tekan
secukupnya untuk menggeser ke atas (Gambar 2.6¢).

e. Blok “00” pada teks “3,00” dan geser ke kanan dengan menekan

seperlunya. Terakhir blok pecahan baris keempat dan geser ke kanan dengan

menekan + seperlunya (Gambar 2.6f), klik di luar area kerja.
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Gambar 2.6

Cobalah Anda praktikan!

Contoh 5

Bagaimanakah cara menuliskan ekspresi ketidaksamaan berikut ini?
AB+A'B'>BC

Cara 1:

Buka Equation Editor: klik = &, klik =, ketik “AB”, tekan [, tekan [+]

ik =& wik B ekan [A] [Ctrl [+ ALt} ], tekan [B], tekan [ Ctrl [+ ALt} ],
tekan [, tekan [>], klik = 2 ik = ketik “BC, tekan [, Klik di luar

area kerja.

Cobalah Anda praktikan!

Cara 2:
Buka Equation Editor: tekan untuk masuk ke toolbar, tekan empat kali

sampai toolbar yang aktif adalah - m‘, tekan , tekan , ketik “AB”, tekan

[>], tekan (memblok), [Cirl]+[c] tekan [>], tekan [+], tekan
[Ctrl[+[v], tekan [« ], tekan [Shift]+ < ], tekan [Shift|+[< ] tekan [A], tekan
(Cul[+{AItH]’], tekan [B], tekan [Ctrl[+{AltH*], tekan [—, |tekan [>], tekan
[Ctrl[+]v], tekan [Shift} <], tekan [Shift]+|<—] tekan [B] ,tekan [C], Klik di luar

area kerja.

Cobalah Anda praktikan!
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Contoh 6

Berikut adalah cara menuliskan ekspresi matematika

!

15° 430’ +20" = (15 60) +30’+(%)

Buka Equation Editor: ketik “15”, tekan | F2], tekan 7 kali sampai ke aooeL

tekan , tekan 2 kali, tekan 3 kali sampai ke i], tekan , tekan ,
ketik “30”, [Ctrl{AIt}"] tekan [+], ketik “20”, [Ctrl}H{ ShiftH{’], tekan [=],
[Curl (], ketik “15”, [CtelHK], [t] ketik “60”, tekan| -], [ Ctrl FH Alt}H{ "], tekan [+],
ketik “30, [Ctrl F{AIt] "], tekan [+], [Ctrl}(], F|, ketik “20”, tekan [{]
ketik “60”, tekan dua kali, ++E|, klik di luar area kerja.

Cobalah Anda praktikan!

>

Contoh 7

Contoh berikut ini mungkin terlalu sulit Anda buat.

x+y=7 |x2| 2x+2y=14
2x+y=9 |x1| 2x+y=9
y=5

Berikut adalah cara menuliskannya.

Buka Equation Editor: klik 88| iiik 8l ketik “x+y=7", tekan [Tab] ketik

“Ox+y=9”, tekan [Tab), tekan [Ctrl}{t][|] (garis tegak), klik oo B ik 8,
++@, tekan , tekan +, , tekan dua kali, tekan ,
tekan [spasil, tekan [Tab], [Ctrl[+[Shift}{e], tekan [spasi], tekan [Ctrl {{k], [t], tekan

M

dua kali, tekan , tekan , tekan dua kali (posisi kursor di paling
kanan), klik " 88| ik 8]  ketik “2x+2y=14", tekan . ketik “2x+y=9”, tekan
, tekan , tekan ++@, tekan seperlunya sampai kursor

di bawah huruf y, klik 2& kik &, tekan seperlunya, tekan

[Ctrl 4] Shift =], ketik “y=5", tekan | Ctrl |+] Shift [+ ], tekan seperlunya agar
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tanda bar mencukupi, tekan , tekan EI, blok notasi “-”, geser notasi “-” ke
tempat yang sesuai dengan menekan + beberapa kali, klik di luar area kerja.

Cobalah Anda praktikan!

B. Kegiatan Belajar 2: Menggunakan Equation 2007

Sebelum pembahasan tentang penggunaan Equation 2007, sebaiknya Anda pahami
bahwa ekspresi matematika yang disisipkan melalui Equation 2007 tidak dapat diedit
di versi MS Word sebelumnya walaupun telah dilakukan penyimpanan melalui Save
As ke versi MS Word 2003. Hal ini disebabkan karena ketika hasil Equation 2007
disimpan ke versi MS Word 2003 atau sebelumnya akan diubah menjadi gambar,
bukan lagi sebagai objek Equation. Meskipun demikian, ketika dibuka kembali
dengan MS Word 2007 objek tersebut dapat diedit sebagai objek Equation.
Sebaliknya, di MS Word 2007 Anda dapat mengedit ekspresi matematika yang
dibuat melalui Equation 3.0 di MS Word versi sebelumnya.

1. Mengedit objek Equation 3.0 di Word 2007

Klik dua kali objek Equation-nya, lakukan perubahan yang diinginkan, klik di luar

area kerja.

2. Menyisipkan objek Equation 3.0 di Word 2007

Klik Insert pada baris menu, kiik ‘$8090t~|  ['d obiec | oqn yap

Create New bagian Object Type pilih Microsoft Equation 3.0, klik OK, susun

ekspresi matematika yang diinginkan, klik di luar area kerja.

Catatan:
Ada baiknya Anda menggunakan Equation 3.0 jika dokumen yang Anda buat
akan dibuka dan diedit di Word 2003. Untuk itu, Anda harus menyimpan
dokumen dalam format MS Word 2003 (dengan eksensi .doc) dengan
langkah:

Klik tombol Office @ pada MS Word 2007, klik Save As,pada kotak teks
Save As Type pilih Word 97 — 2003 document, pada kotak teks File Name
ketikkan nama file-nya, klik Save.
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3. Menyisipkan Equation di Word 2007

Untuk menuliskan ekspresi matematika melalui Equation Anda dapat mengklik

Insert, ‘E_E““?PL"‘L” Perintah ini dapat juga dilakukan dengan shortcut +|E|.

Perintah ini akan memunculkan ribbon seperti gambar di bawah ini.

Wmmmwmmmm%‘ @
T gw N EEEFEFFEREE § eXvx [ 2% oy swe J lim A 3‘-'

Equatios
- d:c MNormal Text

|HHE..E|.|EI. Fraction Script Radical Integral _Large _Bracket Fundtion Accent Limit and Operatar
‘ ~  Operators - - Log~ -
Tools

Gambar 2.7 Tampilan ribbon Equation di MS Word 2007

Terdapat tiga bagian utama dalam tab Design, yaitu Tools, Symbols, dan Structures.
Anda dapat mengklik fasilitas pada Structures untuk mendapatkan femplate yang
Anda butuhkan. Simbol-simbol dan karakter yang tidak terdapat pada keyboard dapat
diambil pada bagian Symbols. Terdapat beberapa pilihan pada Symbol, yaitu Basic
Math, Greek Letters, Letter-like Symbols, Operators, Arrows, Negated
Relations, Scripts and Geometry Related Symbols. Untuk memunculkan berbagai
jenis karakter ini klik tanda panah di ujung kiri bawah kotak Symbol (Perhatikan
penunjuk (pointer) pada Gambar 2.8a) sehingga muncul jendela seperti Gambar 2.8b.

areetenen | ) =] 1) (=] <]
Letter-Like Symbols |E| E
e 0| |G [
vnearestons | ZJEI R[]
EEEHEHEOEEE | s %%E%%

EIHEEIEIEII%@EBEE]EEEEE.

Symbols

(@) (b)

Gambar 2.8 Memunculkan dan memilih karakter pada Symbols

Perhatikan penunjuk pada Gambar 2.8b. Klik pada panah kecil untuk memilih jenis

simbol yang Anda inginkan.
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Contoh 1: Bagaimana menulis ekspresi matematika berikut dalam Equation 2007?

a" =axaxax---xa

n faktor

Langkah-langkah:

Klik Insert pada ribbon, klik K“A“M'JJ klik €, klik =, tekan [« ] dua kali,

tekan , tekan , tekan , tekan E, klik M, klik = tekan tiga
kali, tekan [A ], klik X, tekan [A], klik X, tekan [A], klik X, kiik | Klik
LI, tekan , tekan , tekan , tekan , tekan +, ketikkan

“faktor”, tekan dua kali. Cobalah Anda praktikkan!

Catatan:
Simbol LI, J terdapat pada ribbon Symbol. Jika lambang tersebut tidak
terlihat, Anda dapat mengklik panah turun/naik di ujung kanan kotak Symbols.

Pada contoh di atas perpindahan kursor dilakukan dengan menekan

, , , dan . Anda dapat memindahkan kursor dengan mouse.

Dari contoh di atas, tidak seperti di Equation 3.0 yang memiliki berbagai Style, untuk
menulis dengan huruf tegak pada Equation 2007, perlakuannya sama dengan format

teks seperti pada naskah pada umumnya.

Tips:
Pada Equation 2007 Anda dapat menuliskan perpangkatan dengan mengetik

A

. Sebagai contoh jika Anda mengetik “a”n” maka tampilan yang muncul

2

adalah ”

4. Menyisipkan persamaan melalui Equation Gallery

Klik M dan panah kecil di samping teks Equation, sehingga akan

muncul jendela rumus-rumus Built In seperti Gambar 2.9. tersedia berbagai pilihan
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ekspresi matematika, Anda tinggal memilih yang diinginkan. Setelah memilih salah
satu persamaan, Anda dapat mengubahnya.
)| [A ] & Quickparts - signature e - || TC cauaton]d

Built-In =
Area of Circle

A =nr?

Binomial Theorem

x+a)n= i (:)xkan—k
=)

Expansion of a Sum

—1)x2
(1+x)"=1+%+"(" T Ll

Fourier Series

fx) =ag +Z (a,.cosﬁTm‘+ b,.sinnTﬂ)

n=1

Kl

Insert New Equation

Save Selection to Equation Gallery...

b4
&

Gambar 2.9 Jendela rumus-rumus Built In

5. Menambahkan ekspresi matematika ke dalam Built In Equations

Pada Gambar 2.9 terdapat rumus-rumus atau persamaan matematika tertentu. Anda
dapat menambahkan ekspresi matematika yang Anda buat sendiri dan sering Anda

pakai. Langkah-langkahnya adalah sebagai berikut.
Cara 1:

Klik dan blok ekspresi matematika

:\ eate New Building Block

Hame: (292 J=(x-y)cky)

yang akan Anda simpan. Pada

ribbon Equation Tool, di bagian Galery: | Equations E||
tab Design kelompok Tools, klik Category:  Geners ]
Equation, klik Save selection to Description:

equation  gallery,  schingga saven:  Buidng Blocks x|

Qptions: | Insert content in its own paragraph | v|

Lok [ coxel |

o Gambar 2. 10 Jendela Create New
nama yang anda inginkan pada Building Block

muncul kotak dialog seperti

Gambar 2.10. Selanjutnya, Ketik

kotak teks Name, klik OK.
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Cara 2:

Pada ekspresi matematika yang telah Anda buat

menggunakan Equation, klik pada ekspresi

q; | Save as New Equation...
€% Professional

€% Linear

Change to Display

tersebut, klik tanda panah kecil di samping kanan

(Gambar 2.11), klik Save as New Equation, isi

Justification

kotak teks Name dengan nama yang Anda ingin-
Gambar 2.11

kan, klik OK.

6. Mengubah format persamaan dan ekspresi matematika

a. Tampilan ekspresi matematika: Linear vs. Professional

Terdapat dua jenis tampilan Equation 2007 yaitu Professional dan Linear.
Kondisi default adalah Professional, tetapi jika Anda ingin mengubah tampilan
menjadi Linear, salah satu cara adalah dengan mengklik ekspresi matematika
yang ingin diubah (seperti Gambar 2.12), kemudian klik panah kecil di sebelah

kanannya, dan akhirnya klik Linear.

-b+Vb: =
x= bt :a s » Tampilan professional

x = (=b+ V(b2 - 4ac))/2a — Tampilan linear

Gambar 2.12 Tampilan persamaan Professional dan Linear

Cobalah Anda praktikan!

b. Tampilan ekspresi matematika: Display Mode

Ekspresi maupun persamaan matematis pada Equation 2007 dapat ditampilkan
dalam modus inline with text, atau in display. Pada posisi in display mode,
ekspresi tersebut dapat diletakkan di tengah baris tersendiri (tidak bercampur

teks) baik secara individual maupun grup.

Berikut adalah contoh-contoh tampilan dalam modus inline with text dan

in display.

Persamaan x = % ditempatkan pada posisi inline.

Gambar 2.13 Tampilan persamaan pada modus inl/ine with text
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Persamaan
—b +Vb? —4ac
x -
2a

Ditempatkan pada posisi Display Mode.

Gambar 2.14 Tampilan persamaan pada modus display

Anda dapat menyisipkan Equation ketika kursor berada di akhir kata

“Persamaan”. Tekan , klik ‘ﬁ“&“ﬂtﬂ, ketik rumusnya, tekan , tekan
, lanjutkan teks berikutnya. Otomatis rumus yang dibuat akan berada pada

posisi inline. Perhatikan bahwa ekspresi matematika dalam posisi in/ine menjadi

sedikit lebih kecil jika dibandingkan terhadap posisi display mode.

Jika Anda menulis menggunakan Equation 2007 pada awal paragraf, otomatis
posisinya berada pada display mode. Anda dapat mengubah ke bentuk inline
dengan dengan masuk ke ekspresi matematikanya, kemudian klik panah kecil di
sebelah kanan dan klik Change to inline. Demikian juga sebaliknya, ekspresi
matematika yang berada dalam kondisi inline dapat diubah ke bentuk display
mode dengan masuk ke ekspresi matematikanya, kemudian klik panah kecil di

sebelah kanan dan klik Change to Display.
Cobalah Anda praktikan!

7.  Mengatur persamaan multibaris dalam posisi Centered, Centered as

Group, dan rata pada tanda =

Untuk memudahkan pembacaan persamaan Anda dapat mengatur posisi persamaan

yang terdiri atas beberapa baris dalam format di tengah baris, di tengah sebagai satu

kesatuan, atau rata pada posisi tanda

—b +Vb? — 4ac
x ——
2a

2ax = —b ++/b? — 4ac
2ax + b= +/b* — 4ac

Gambar 2.15 Kumpulan persamaan dalam posisi Centered
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btV —dac

2

a
2ax = —b ++/b? — 4ac
2ax + b= +/b* — 4ac

Gambar 2.16 Kumpulan persamaan dalam posisi Centered As Group

x

—b +Vb? —4ac
e
2a

2ax = —b ++/b? — 4ac
2ax + b = +b? — 4ac

Gambar 2.17 Kumpulan persamaan dalam posisi rata pada tanda =

Pada Gambar 2.15, 2.16, dan 2.17 terdapat tiga baris persamaan dalam susunan yang
berbeda. Untuk memposisikan ketiga persamaan dalam kondisi seperti di atas, klik
salah satu persamaan, klik tanda panah di sebelah kanan persamaan, klik
Justification, klik Centered (untuk Gambar 2.15), atau Centered as Group (untuk
Gambar 2.16).

Sementara itu untuk mendapatkan tampilan Gambar 2.17, blok semua persamaan

kemudian klik kanan pada bagian yang diblok dan terakhir klik align at =.

Jika langkah di atas tidak berhasil, posisikan persamaan dalam centered as group
terlebih dahulu.

C. Ringkasan

Untuk menampilkan ekspresi matematika yang lebih rumit, Anda tidak cukup hanya
menggunakan fasilitas Symbol pada MS Word. Anda dapat menggunakan fasilitas
tambahan, yakni Microsoft Equation 3.0 pada MS Word 2003 dan Equation 2007
pada MS Word 2007.

Dalam berbagai hal, kedua fasilitas tersebut memiliki banyak perbedaan baik dari segi
tampilan maupun kompatibilitasnya. Ekspresi matematika yang ditulis menggunakan

Equation 2007 tidak dapat diedit dengan MS Word 2003. Namun demikian, ekspresi

matematika yang ditulis menggunakan Equation Editor 3.0 dapat diedit
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menggunakan MS Word 2007. Hal ini dikarenakan MS Word 2007 tetap dilengkapi
dengan Equation Editor 3.0.

Jika diinginkan, jenis font, ukuran font, dan pengaturan spasi dapat diganti sesuai
kebutuhan. Selain menggunakan mouse, untuk memindahkan kursor dapat juga
digunakan tombol-tombol panah kiri, panah kanan, panah naik, panah kiri dan tombol
tab. Berbagai kombinasi shortcut telah tersedia dan dapat dibuat untuk mempercepat
proses pengetikan naskah. Bagi yang telah hafal dengan berbagai kombinasi shortcut,

proses pengetikan naskah menjadi lebih cepat daripada dengan menggunakan mouse.

D. Latihan

Ketikan ekspresi matematika atau paragraf pada setiap nomor soal berikut. Anda

boleh menggunakan Equation 3.0 maupun Equation 2007.

L _n(k)
P(K)= n(S) dengan K — §

2. Buatlah AK dan AL.
Perhatikan AAKP, <ZAKP
menghadap diameter lingkaran
pusat T. Jadi besar ZAKP = a90°,
Dengan  demikian garis
singgung pg L AK dan PLL
AL. PLAK disebut layang-
layang garis singgung.

Keterangan:
Salah satu soal yang terdapat pada Buku Sekolah Elektronik. Pemenggalan
salah satu ekspresi matematika kurang bagus. Salin dan perbaikilah.

3. Besar ZASN

Besar £JSA4
4. U,=axXrxXrxrx--xr
| ———
(n-1) faktor
5. n
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6. x+y=3
2x=10-2y

Keterangan:
Persamaan disusun rata menurut tanda sama dengan.

7.
Panjang busur 4B = 43120003 X 2mrr

60°

3600
1

=—nr

3

X2XTTXF

Keterangan:
Persamaan disusun rata menurut tanda sama dengan.

— x —
2 3
5 6
URH
4 4
9. S, - n@+Uu,)
2

Keterangan:
Gunakan jenis huruf Comic Sans MS untuk variabel.

10. 1 + 2 4+ 3 4+~ +Mm-D+ n = §,
n +m-D+m®-2)+--+ 2 + 1 = §,

+
(A+n) + I+n) + (+n) + -~ + (1+n) + (1+n) = 25,

n suku

Keterangan:
Tanda + dan = terletak pada satu kolom.

Sampai di sini Anda telah belajar menggunakan fasilitas Equation Editor, baik pada
MS Word 2003, maupun MS Word 2007. Setelah mengerjakan soal latihan, Anda
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dianggap berhasil jika dapat mengerjakan minimal 75% dari semua soal yang
disediakan. Jika Anda sudah mencapai target tersebut, Anda dapat membantu rekan
yang masih mengalami kesulitan. Bagi yang belum dapat mencapai target minimal
75%, sebaiknya membaca ulang, memperhatikan contoh-contoh, bertanya dan

berdiskusi dengan rekan-rekannya.

E. Umpan Balik

Setelah mengerjakan soal latihan, berikut ini dapat dijadikan acuan untuk hasil

pekerjaan Anda. Untuk soal nomor 1, Anda dapat menggunakan gabungan antara

: K
Equation pada P(K) =%, teks normal pada kata “dengan”, “K” dan “S”, serta
n

menggunakan Symbol untuk “c”. Jangan lupa menggunakan | Ctrl [+ Shift | Enter |

dalam memberikan spasi. Cara lain adalah dengan mengetikkan seluruhnya
menggunakan Equation dengan catatan, pada kata “dengan” digunakan Style Text.

Meskipun hasilnya sama, penulisan “P(K) = dengan menggunakan teks biasa,

kemudian n( ) menggunakan Equation sebaiknya dihindari.
n

Untuk soal nomor 2, perhatikan penggunaan notasi ruas garis, garis, dan sudut

sebaiknya menggunakan huruf /talic. Pengetikan seperti PL 1 AL akan lebih baik
jika seluruhnya menggunakan Equation Editor sehingga ekspresi tersebut tidak

terpenggal di tepi kanan paragraf.

Soal nomor 3, 4, 5, dan 8 cukup mudah dikerjakan. Anda tinggal menggunakan
template yang tersedia dan mengganti Style antara Math dan Text di bagian-bagian
yang dikehendaki.

Untuk soal nomor 6, gunakan template pada kelompok Fence (kurung) dan Matrix.
Untuk meratakan pada tanda “=", blok kedua persamaan saja (tanpa kurung kurawal
di depannya), klik Format, klik Matrix, pada jendela Matrix yang muncul klik pada
Align at =.

Pada soal nomor 7, ketikkan seluruhnya pada satu area kerja Equation Editor
dengan menekan tombol untuk berpindah ke baris berikutnya. Untuk
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meratakan pada tanda “=”, dalam posisi area kerja aktif, klik Format, klik
Align at =.

Soal nomor 9 cukup mudah dikerjakan. Anda tinggal mendefinisikan sendiri Style-

nya dengan klik pada Style, klik Define, lakukan perubahan yang dikehendaki.

Diperlukan trik untuk mengerjakan soal nomor 10. Gunakan 13 buah matriks 4x1
untuk baris pertama dan kombinasikan Style Math dan Text untuk mengatur jarak
spasinya. Pada masing-masing matriks, kosongkan baris ke-4. Pada baris kedua,
isikan dengan pecahan dan “+” dan gunakan Style Text. Tekan batang spasi secu-
kupnya untuk memperpanjang garis penjumlahan bersusun. Pada baris ketiga,
gunakan template yang tersedia pada kelompok Fence dan aplikasikan Style Text
untuk memperpanjang tanda. Berikut ini hasil langkah-langkah di atas.

1 + 2 + 3 4+-+m@-D+ n =S,
n +m-)+m®-2)+--+ 2 + 1 = §,
(+n) + A+n) + I+n) + --- + (I+n) + (1+n) = 2§,

n suku

Langkah berikutnya adalah mengeblok baris kedua dan ketiga kemudian geser ke atas
per satu piksel sehingga diperoleh hasil yang diinginkan.

Setelah tuntas mempelajari modul ini diharapkan Anda mampu:

v" Menuliskan ekspresi matematika yang lebih rumit menggunakan Equation
Editor,

Mengubah style pada ekspresi matematika,

Membuat style sendiri,

Mengatur posisi beberapa persamaan yang berada dalam satu kelompok,

DN N NN

Mengetahui keberadaan dan mampu menggunakan berbagai shortcut untuk

mempercepat pengetikan naskah.
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Dalam naskah yang biasa Anda buat, mungkin terdapat gambar-gambar yang
diperlukan untuk mendukung penjelasan/uraian tekstual. Sampai sekarang mungkin
Anda masih mengalami kesulitan menyisipkan atau membuat gambar bangun-bangun
geometri yangs ering diperlukan pada teks-teks matematika. Anda akan mempelajari-

nya pada Modul 3.
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MODUL 3
MEMBUAT GAMBAR DENGAN MS WORD

Salah satu tahapan penting dalam proses belajar mengajar matematika yang harus
dilakukan oleh guru adalah penyiapan naskah pembelajaran matematika. Dalam
naskah matematika tidak sedikit terdapat gambar-gambar yang harus dibuat untuk
keperluan pembelajaran. Gambar yang baik, benar, dan menarik tentu sangat
membantu siswa dalam memahami dan meningkatkan minat belajar matematika.
Aplikasi MS Word mempunyai banyak fasilitas yang sederhana, mudah digunakan,
dan memadai untuk menggambar bangun-bangun geometri. Hal ini dapat dimanfaat-
kan untuk membantu mempercepat penyediaan gambar di dalam naskah yang akan

Anda buat.

Modul ini dapat digunakan oleh guru-guru matematika maupun guru mata pelajaran
lain yang ingin mengoptimalkan pemanfaatan MS Word untuk menggambar
terutama menggambar bangun-bangun geometri dalam penyiapan naskah dengan
menggunakan fasilitas Drawing. Modul ini dirancang menggunakan MS Word 2003.
Namun demikian dibahas juga penggunaan MS Word 2007 sehingga berguna bagi
Anda yang bekerja menggunakan MS Word 2007.

Beberapa hal yang dibahas dalam modul ini di antaranya adalah sebagai berikut.

1. Bagaimana cara memunculkan toolbar Drawing (fasilitas untuk menggambar),
mengingat tidak semua komputer ketika MS Word dijalankan fasilitas

gambarnya langsung muncul.

2. Apa saja fasilitas yang ada dalam foolbar Drawing serta bagaimana cara

menggunakannya.
3. Bagaimana langkah-langkah praktis untuk:
a. menggambar titik dalam koordinat kartesius,

b. menggambar garis lurus maupun lengkung (tanpa anak panah, dengan anak

panah tunggal maupun ganda) dengan berbagai ragam variasi,
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c. menggambar garis tegak lurus maupun dengan sudut tertentu,
d. menggambar busur dan juring,
e. menggambar segitiga siku-siku,

f. menggambar bentuk-bentuk bangun datar dan bangun ruang yang tidak

terdapat di autoshapes,
g. memberi arsiran dan membuat transparan,
h. membuat papan berpetak (grid), dan lain-lain.

Modul ini terdiri atas dua kegiatan belajar. Pada kegiatan belajar 1 Anda akan
mempelajari seluk-beluk tentang fasilitas Drawing pada MS Word. Pada kegiatan
belajar 2 Anda akan belajar cara membuat berbagai macam gambar bangun geometri

dan kurva/grafik.

Modul ini diharapkan dapat memberikan solusi terhadap berbagai permasalahan
menggambar bangun-bangun matematika menggunakan MS Word dalam penyiapan

naskah.

A. Kegiatan Belajar 1: Mengenal Fasilitas Drawing

Fasilitas untuk menggambar pada MS Word berada di foolbar Drawing.
Bagaimanakah cara memunculkan foolbar Drawing? Apabila pada halaman MS
Word belum terlihat toolbar Drawing, Anda dapat memunculkannya dengan cara

sebagai berikut.

=

iew ilnsert Format  Tools  Table  Window Help

-~ R ¥ B@ I 9o
5 web Layout ﬂ .
| Prink Layout

TaskPane  Chrl+F1

Toolbars !1E| Standard
Ruler Farriatting

LO0M, .. AutaText

¥ Cantral Toolbox

Database

E-mail

Farms

Gambar 3.1 Menampilkan toolbar Drawing
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Klik menu View pada toolbar, arahkan mouse ke submenu Toolbars, klik submenu
Drawing. Toolbar Drawing akan muncul pada bagian bawah halaman MS Word.
Toolbar ini dapat dipindah letaknya dengan cara mendekatkan kursor pada sebelah
kiri tulisan Draw pada toolbar Drawing sampai kursor berubah bentuknya menjadi
ujung panah empat arah, kemudian drag dan drop pada tempat yang diinginkan.

Draw = ¢ | Autoshapes = ™ [ O S RE S F-A-== B @

Gambar 3.2 Tampilan toolbar Drawing dengan header

Ketika toolbar Drawing dipindah ke bagian dalam lembar kerja (layar editor) maka
akan berubah menjadi seperti Gambar 3.2. Untuk menggesernya Anda tinggal klik
bagian atasnya (header), tahan dan lepaskan pada tempat di mana Anda akan
meletakkan.

@da MS Word 2007, tool untuk menggambar terdapat pada tab Insert. \

Gambar 3.3 Tampilan tab Insert pada MS Word 2007

. J

Masing-masing bagian pada toolbar Drawing akan dijelaskan sebagai berikut.

brawing |
1. DraW Qraw'l[} | Autoshapes = ™, ™
Menu Draw memiliki beberapa submenu sebagaimana % fg”p
terlihat pada Gambar 3.4: B Reoroup
Qrder »
a. Group # o
Hudge »
Digunakan untuk menyatukan beberapa gambar Algn or Distribute »
. . . . Ratate or Flip 3
menjadi satu kesatuan sehingga apabila gambar tersebut | 1., yrupping 3
digeser-geser maka semua gambar dalam satu grup akan E ;tptft
ikut bergeser semua. Change Autoshape b
Set AutoShape Defaults
Gambar 3.4

Submenu Draw
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b. Ungroup
Digunakan untuk memecah/memisahkan kembali bagian-bagian gambar yang

sebelumnya pernah di-group.

c. Regroup
Untuk meng-group kembali beberapa gambar yang baru saja dipecah/
dipisahkan.

iy b
Pada MS Word 2007, Group, Ungroup dan) | o= """

Regroup terdapat pada tab Format = Arrange -> I¢| Group

Group (lihat Gambar 3.5) . g Regroup

Gambar 3.5
d. Order
Digunakan untuk mengatur urutan penempatan gambar, untuk meletakkan
gambar mana yang di depan dan gambar mana yang di belakang ataupun letak

gambar terhadap tulisan. Submenu Order adalah sebagaimana terlihat pada

Gambar 3.6.
3 Bringto Front — Diletakkanpaling depan
24 Sendto Back —+ Diletakkanpaling belakang
) Bring Forward — Diletakkansatulangkahke depan
Y send gackward —» Diletakkansatulangkahke belakang
& eringinFront of Tet — Diletakkan di depantulisan
&) sendeehindTet  —» Diletakkan di belakangtulisan

Gambar 3.6 Submenu Order

Cara mengatur urutan penempatan beberapa gambar adalah sebagai berikut:

1) Klik gambar yang akan diubah urutan penempatannya.

2) Klik Draw, klik Order, pilih salah satu letak urutan penempatan pada
submenu Order (Gambar 3.6).
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Pada MS Word 2007\
i D—|
Order terdapat pada tab @j DI_—|_L| |E s
Format > Arrange. Pilih | [sinotelsenato  1ex 4 [Sendtsl Tec - Align
g ront = | Back~ rapping * k™ rapping * *
Brlng to Front atau Sent L4, Bring to Front | H—“.a Send to Back
to Back (lihat Gambar 3.7) f |5 i comerd

‘ {% Bring in Front of Text

I
=
Cie

[ Eh Send Backward
El | send Behind Text

Gambar 3.7
e. Grid
Grid digunakan untuk menampilkan garis-garis tegak maupun garis mendatar
guna memudahkan proses menggambar. Untuk menampilkan Grid Anda dapat

mengikuti langkah-langkah berikut ini:

1) Klik menu Draw,

: i

2) Klik submenu Grid, maka akan muncul kotak S !

Snap to
. _ _ _ it mmm——
dialog Drawing Grid seperti Gambar 3.8. Focai: e

Grid settings
Hotizontal spacing: |1 cm E‘

Berikut keterangan singkat tentang fasilitas yang el peey o S
Grid arigin

terdapat pada pada kotak dialog Drawing Grid. Y e Fre—=]

Wertical origin: |2.54 o E

v Display gridlines on screen

» Snap objects to grid: jika ini dicentang maka

¥ Wertical every:

I

Hotizantal every:

ujung-ujung gambar akan melekat pada grid.

Default. .. | oK I Cancel |

Gambar 3.8 Kotak dialog
maka ujung-ujung objek akan melekat pada Drawing Grid

» Shap objects to other objects: jika dicentang

objek yang lain.
» Grid settings: untuk menentukan ukuran grid.
» Grid origin: untuk menentukan posisi dari grid.

» Display gridlines on screen: jika dicentang maka grid akan ditampilkan

pada layar/lembar kerja.

Pada MS Word 2007, Gridlines terdapat pada tab View->Show/Hide,
Gridlines (lihat Gambar 3.9) atau tab Page Layout - Arrange = Align
- View Gridlines
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= A“gn"'] &1 lng7-

|=  align Left

Align Center
Align Right

| W e

=

Align Top

&

Align Middle

=

Align Bottom
Distribute Horizontally
Distribute Vertically

References  Mailings  Review | View |

e &

Align to Page

=

¥ Ruler ' Document Map q Alighto Margin

" Gridlines | Thumbnails = Align Selected Objects
Zoom 1
View Gridlineg

#if  Grid Settings...

[] Message Bar
Show/Hide

Gambar 3.9

f.  Rotate or Flip
Submenu Rotate or Flip adalah sebagaimana terlihat pada Gambar 3.10. Pada

bagian kiri terdapat gambar dan sebelah kanannya ada tulisan keterangan.

@ FreeRotate Memutar gambar dengan sudut bebas
= Rotate Left 90° Memutar gambar 90° ke arah kiri

Sk Rotate Right 90° Memutar gambar 90° ke arah kanan

Ak Flip Horizontal Membalik gambar arah mendatar

= Flip vertical Membalik gambar arah tegak

Gambar 3.10 Submenu Rotate

or Fllp e 4] Height: |0.98"
ﬁutvate Crop £ width: 5?.35;
Sk Rotate Right 90°
1 42 Rotate Left90°
Pada MS Word 2007, Rotate terdapat B
pada tab Format - Arrange - Ak Fip Horizonta
Rotate (lihat Gambar 3.11) bore Rotaton Optos.

Gambar 3.11

g. Edit Points
Edit Points digunakan untuk mengedit gambar/objek yang telah Anda buat
menggunakan fasilitas Lines namun belum sesuai dengan yang diharapkan. Cara

mengedit gambar garis dengan Edit Points adalah sebagai berikut:

1) Klik (aktifkan) objeknya
2) Selanjutnya klik Draw - Edit Points
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3) Kilik pada objek tersebut, tahan tekanan pada mouse dan tarik ke arah yang
Anda inginkan kemudian lepaskan. Ulangi pada bagian-bagian lain dari

objek tersebut yang akan diubah.

Pada MS Word 2007, apabila
Anda menggambar objek yang | E\ OO0 g
dapat dilakukan Edit Points terha- | AL LU0 -
dapnya, maka akan muncul tab % —\rt\{n si L
Format, Insert Shapes, Edit e

Points (lihat gambar 3.12) Gambar 3.12

¢<  Edit Points

2. Select Objects

Jika ikon Select Objects L ini diklik/diaktifkan, maka Anda dapat memilih dacrah
dalam bentuk persegi untuk melingkupi beberapa gambar tertentu sehingga gambar
tersebut dapat diedit maupun di-group. Akan tetapi, pada kondisi ini Anda tidak dapat

memindahkan kursor pada naskah menggunakan mouse.

Pada MS Word 2007, Select Objects terdapat di tab Home - Editing
-> Select =2 Select Objects

2, Hyperlink
= el o

3. AutoShapes i s s
Recently Used Shapes -
Submenu pada AutoShapes adalah sebagai berikut. L A

Lines
Bl o L S S e A P

Basic Shapes

vf\’?' Lires » BOOUCO® ADOOD
3 S COO0OADEOEO Y X\ G
A Basic Shapes 2 0O
Block Arrows
% Block Arrows 2 DGO OTEEPR S I
To Elowchart 3 égxmﬂ>$DDD@fﬂﬁ
?‘éﬂ Stars and Banners Pk Flowchart
OocoOiideocay
¥ Callouts 4 990086 6 AVGD
@
& More AutoShapes... Dﬂg‘gaﬂﬂﬂ@J g
AumShapes = ™ % c ./ AP 2 18 4D AD (B
Stars and Banners
Gambar 3.13 RN HOEBEBTAY
fin = av] WA

-ﬁ MNew Drawing Canvas

Gambar 3.14

Pada MS Word 2007, submenu AutoShapes terdapat pada rab Insert
- Shapes (lihat Gambar 3.14)
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Bagian-bagian pada submenu AutoShapes adalah sebagai berikut.

a. Submenu Lines
Bagian dari submenu Lines sebagai berikut (Lihat gambar 3.15):

(1): digunakan untuk menggambar garis lurus.

2
+ (2): digunakan untuk menggambar garis lurus
1lar- i
P et beranak panah satu (Arrow).
cafd O %oy , ,
- (3): digunakan untuk menggambar garis lurus
3
Gambar 3.15 beranak panah dua (Double arrow).
(4): digunakan untuk menggambar garis
sembarang (Scribble).

(5): digunakan untuk menggambar kurva dengan sudut tajam (Freeform).

(6): digunakan untuk menggambar kurva lengkung (curve).

b. Submenu Basic Shapes (bangun dasar)
Gambar 3.16 menampilkan ikon-ikon yang dapat langsung digunakan untuk
menggambar bangun-bangun dasar sepeti bangun beraturan (segitiga sama sisi,

persegi, segilima beraturan), bangun ruang (tabung, kubus, balok) dan lain-lain.

0090 >G0d O
o0ADN O D D $ §3
o000 PRSI DAOA040
800 ESwvwn 4 A A d
©00a OoDDD

206¢ COAR pighingiel,
0o g e,

(1<) oOoA LDAAD
Gambar 3.16 Gambar 3.17 Submenu Gambar 3.18
Submenu Basic Block Arrows Submenu Callouts

Shapes

c. Submenu Block Arrows
Gambar 3.17 menampilkan berbagai macam ikon anak panah tebal dalam

berbagai bentuk, dapat langsung digunakan dengan cara mengklik pada salah

satu ikon, kemudian meletakkannya pada bidang gambar yang Anda kehendaki.
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d. Submenu Callouts
Gambar 3.18 menampilkan berbagai macam bentuk kotak callout disediakan
pada bagian ini. Di dalam kotak callout tersebut dapat diisi teks/tulisan sesuai

dengan kebutuhan.

e. Submenu Flowchart
Bagian ini biasanya digunakan untuk menggambar diagram alir (flowchart)
untuk menjelaskan suatu proses, seperti algoritma (langkah-langkah) dalam suatu

kegiatan.

f.  Submenu Stars and Banners
Pada bagian ini tersedia berbagai rancangan gambar bintang (stars) serta model
banner, seperti: 4-point start, 5-point start, 8-point start, explotion, Horizontal

Scroll, Vertical Scroll dan lain-lain.

Oo0< 7 | . :
Ooooe Y 3 < oy
=0y
o oK & ® ﬂ' @
RE I 6 e B H
AvTAap :
QBeoo : E r,j N E::J
Gambar 3.19 Gambar 3.20 Submenu
Submenu Flowchart Star And Banner

4. lkon Garis (Line)

Garis (Line) ini juga terdapat di dalam submenu Lines

5. Ikon Garis Beranak Panah Tunggal (Arrow)

Garis beranak panah tunggal (4rrow) ini juga terdapat di dalam submenu Lines

6. lkon Persegi Panjang (Rectangle)

Persegi (Rectangle) juga tersedia di dalam menu Basic Shapes

7. lkon Elips

Elips juga tersedia di dalam menu Basic Shapes
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8. lkon Text Box

Text Box dapat digunakan untuk berbagai macam keperluan misalnya menulis teks
yang dapat dengan mudah dipindah-pindah letaknya, menulis teks untuk nama suatu

gambar.

Suatu fext box dapat diatur dengan mengklik kanan kemudian pilih/klik Format
Text Box. Dalam Format Text Box ini dapat diatur beberapa hal seperti warna,

garis, ukuran /ayout dan sebagainya.

Pada MS Word 2007, Text Box terdapat di zab Insert > Shapes >
Basic Shapes atau di fab Insert > Text.

9. Ikon Insert WordArt
WordArt digunakan untuk menulis huruf, kata atau kalimat yang bentuknya artistik.

Untuk menggunakan WordArt klik ﬂ, sehingga muncul jendela WordArt
Gallery. Klik salah satu model penulisan (WordArt Style) yang Anda inginkan,
seperti terlihat pada Gambar 3.21.

wordart Gallery x|

Select a Wordart style:

Wardit {yyordAT |aworaa, WordArt Woraart | 2

Wzl |WordArt [WordRet w0742+ | Wit

e IRRUESLE ICEPTRTE
= ¥ &

Wit |WordAR | woan | WordArt |WordA
Wordaet (rdArt [Wordet | Wi [snuzi]
Gambar 3.21 Jendela Wordart Gallery

w
L]

APaveg| ~pnand)| -omsocs wanevel] o

[ Pada MS Word 2007, WordArt terdapat di tab Insert > Text-> WordArt ]
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10. lkon Diagram or Organization Chart

Apabila Anda ingin menyisipkan diagram atau bagan organisasi klik ikon fal ,
sehingga muncul Diagram Gallery dengan berbagai macam bentuk (#ype) diagram,
sebagaimana terlihat pada Gambar 3.22. Pilih salah satu #ype kemudian klik OK

untuk menggunakannya.

Pada MS Word 2007, Diagram Gallery terdapat di tab Insert >
Ilustrations > SmartArt

B Academic
‘ Fle Edt Mew Tools Help

- Microsoft Clip Organizer

1 search... [ ColectonList... || S 1%, % [[Fa]i5 8 % dips onine
: Collection List -
= o5 o K
1
L7 oo =iy
o] 2o 51 Office Collections -
435 heademic

academics, buses, school buses. ..
| é 261 (w) x 262 (h) pixels, 6 KB, WMF
COrganization Chart
Used ko showe hierarchical relationships

©

=]
ITI Cancel | § g
Gambar 3.22 ] -
Jendela Diagram Gallery e - i
Gambar 3.23 Jendela Microsoft Clip
Organizer

11. Ikon Insert ClipArt

Jika Anda klik Insert ClipArt maka akan muncul subpanel ClipArt pada sebelah
kanan layar. Pada bagian bawah subpanel terdapat Clip Organizer. Apabila Anda
klik Clip Organizer maka akan muncul kotak dialog Microsoft Clip Organizer
yang berisi berbagai gambar seperti pada gambar 3.23. Di bagian kiri kotak dialog
terdapat berbagai macam kategori gambar, misalnya Academic, Agriculture, Arts,
Business dan lain-lain. Gambar-gambar yang tampil di sebelah kanan dapat
disisipkan ke naskah dengan cara mengklik tanda panah ke bawah di sebelah kanan

gambar, selanjutnya pilih Copy, kemudian pada naskah klik Paste.

12. lkon Insert Picture

Selain gambar dari ClipArt, gambar dari file yang sudah Anda miliki dapat

disisipkan ke dalam naskah melalui Insert Picture. Klik pada ikon Insert Picture
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( ), sehingga muncul jendela seperti Gambar 3.24. Pilih gambar yang Anda
inginkan, selanjutnya klik Insert.

Ieset Ptore 3%
[ f:):.-_n-.——;].b-j QX 5 - tek

O

CHE e

» -

it

e

My Compuiter -

g Plgme | - re=t .I
-': Ll o =] Carcel

Gambar 3.24 Jendela Insert Picture Gambar 3.25 Gambar Blue Hill

Misalnya Anda memilih gambar Blue Hill. Setelah menyisipkan gambar tersebut ke

dalam naskah, Anda dapat mengeditnya dengan cara:

Klik kanan pada gambar dan pilih Show Picture Toolbar, sehingga muncul kotak
dialog Picture seperti Gambar 3.26. Terdapat beberapa fasilitas yang ada di sini dan
belum tersedia pada toolbar Drawing.

Pictwre  vXx
= W'{JIQ\I/.&I gl FLESHEY Z %

Mare Contrastl Less/éontrastl C‘ropl \

More Brightnes Lessérightnessl Set Transparent Colorl

Gambar 3.26 Jendela pengaturan gambar
Tabel 3.2

\[o} Perintah Kegunaan

1. | More Contrast Untuk menambah kekontrasan objek/gambar,
lawannya adalah Less Contrast.

2. | More Brightness Untuk menambah kecerahan objek/gambar,
lawannya adalah Less Brightness.

3. | Crop Untuk memotong objek/gambar.
4. | Set Transparent Untuk mengatur tingkat transparansi gambar
Color pada bagian solid color

Pada MS Word 2007, Picture dan ClipArt terdapat di tab Insert >
Ilustrations
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13. lkon Fill Color

Fill Color digunakan untuk memberi warna suatu daerah pada gambar. Jika ujung

anak panah: ‘v’ di sebelah kanan ikon Fill Color diklik, maka akan diperoleh
berbagai pilihan warna. Selain warna yang tampak di situ, juga dapat dicari warna

lain dengan cara klik pada More Fill Color, atau klik Fill Effect untuk jenis

pengarsiran, gambar, tekstur atau gradient.

x

L
EEEEEEERN
EEEEEEEN
EOCONEENE
BOOOOB®EO

Mare Fill Colors, .

Fill Effects... T ol e =

Gambar 3.27 Pilihan warna pada Fill Gambar 3.28 Jendela Colors
Color
» Klik pada More Fill Color sehingga muncul pilihan warna seperti terlihat pada

Gambar 3.28.
» Klik pada Fill Effect sehingga muncul berbagai pilihan seperti terlihat pada

Gambar 3.29.

St ) [ pada MS Word 2007, Fill color diberi istilah

| voars | paten | s |
== | Shape Fill sedangkan Line Color diberi istilah
Shape Outline. Kedua fasilitas ini terdapat
pada tab Format = Shape Styles
.
ample: : o
BB :
— = [P~
Gambar 3. 29 Snape stytes 5

Jendela Fill Effect Gambar 3.30

Bagian yang dapat diisi warna adalah bangun-bangun datar tertutup baik yang berasal

dari AutoShapes maupun gambar bebas.
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14. lkon Line Color

Digunakan untuk mewarnai garis yang terlebih dahulu telah dipilih. Pilihan warnanya

sama dengan yang disediakan pada Fill Color.

15. Ikon Font Color

Digunakan untuk mewarnai huruf/angka/karakter yang terlebih dahulu telah dipilih.

Pilihan warnanya sama dengan yang disediakan pada Fill Color.

16. lkon Line Style

Line Style digunakan untuk memberikan beberapa pilihan ukuran ketebalan garis dan
juga kombinasi garis. Anda juga dapat mengklik tulisan More Lines, sehinga muncul
kotak dialog Format AutoShape. Pada kotak dialog tersebut Anda dapat menentukan
beberapa pilihan untuk Line maupun Arrows.

Format AutoShape x|

Colors and Lines I Size | Layout | Pickure I Texk Box I heb I
Fill

Colar: -
Transparency; LI ﬂ 0% 5‘

Calar: I - Style: -
Dashed: e Waight: 0,75 pt 5‘

Beqin style: End style: lﬁ
Begin size: EI - End size: lﬁ
-
Ok Cancel |
Gambar 3.31 Jendela Format AutoShape

17. 1kon Dash Style

Dash Style menyediakan fasilitas berupa variasi pilihan garis. Tersedia variasi garis

penuh, garis putus-putus atau garis titik-titik dengan berbagai kombinasi pilihan.

18. lkon Arrow Style

Arrow Style menyediakan fasilitas berupa variasi bentuk garis, baik garis lurus, garis
dengan anak panah tunggal, garis dengan anak panah ganda dan lain-lain. Dengan

fasilitas ini Anda dapat mengatur bentuk dan arah tanda panah pada ujung suatu

gambar garis.
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Gambar 3.32 Gambar 3.33 Gambar 3.34
Isi ikon Line Style Isi ikon Dash Style Isi ikon Arrow Style
28— | P%a

Pada MS Word 2007, Line Style, Dash Style dan Standard Colors
Arrow Style terdapat pada tab Format > Shape N
Styles & Shape Outline (lihat gambar 3.35)

More Cutline Colors..

Weight »

= Dashes »
-
= | Arrows 3

Pattern...

Gambar 3.35

19. Ikon Shadow

Shadow menyediakan fasilitas pemberian variasi model bayang-bayang (shadow)
suatu bangun datar (lihat Gambar 3.36). Pada fasilitas ini masih ada fasilitas lain yaitu

pilihan warna bayangan.

i NnSl‘Enw !

r..11|:| Cr "i-f.ie-.-p-!v

N el EEEENENEN

iy HEEEEEEER

D Boo EEEENEENEN
||_—. m L HEE(EEENEN
B = EECOOCOERO
"L == ~

e e e Semitransparent Shadow
Shadow Settings... Mare Shadow Colars. ..
1F).

Gambar 3.36 Beberapa bagian pada ikon Shadow
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20. lkon 3-D Style

Pilihan 3-D menyediakan fasilitas pemberian variasi model bayang-bayang gambar
bangun ruang (dimensi tiga). Pengaturan dimensi tiga, selain dengan memberikan

pilihan warna bayang-bayang juga dapat berupa perputaran gambar.

o |
| %ocoe gawme-
® = _
! g O fukarnatic
EEEEEEEN
N = EEEEEEEE
! @ EEEEEEEN
EEMEEEEN
ﬁ ﬁ BEECOOCOEMN I:l_
| D settings.. | Mare 3-D Colors...
=1
Gambar 3.37 Beberapa bagian pada ikon 3-D
Review View Add-Ins | Format
Pada MS Word 2007, Shadow terdapat D o |*] e
pada tab Format - Shadow Effects, dan o | F Zﬁ T R
Format - 3-D Effects il |\ Etets- | &
Shadow Effects 3-D Effects

Gambar 3.38

B. Kegiatan Belajar 2: Teknik Menggambar

1. Menggambar titik

Untuk menggambar titik Anda dapat mengikuti langkah-langkah sebagai berikut ini.

a. Mencari letak di mana fasilitas untuk menggambar tersebut berada. Pada contoh

ini titik dapat digambar menggunakan elips. Fasilitas tersebut terdapat pada

Autoshape - Basic Shape atau pada ikon @

Pada MS Word 2007 fasilitas ini terdapat di Insert = Shapes = Basic
Shapes.

b. Klik pada ikon @ . Ketika pointer digeser menuju halaman kerja akan berubah

bentuknya menjadi “+”.
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Letakkan pusat “+ di titik awal calon objek, tahan tekanan pada mouse sambil
menekan tombol (supaya objek benar-benar berbentuk lingkaran), tarik
sepanjang diameter lingkaran yang Anda inginkan, lalu lepaskan tekanan pada

mouse.

. Diperoleh gambar: m atau m (pada MS Word 2007). Adanya lingkaran
kecil pada tiap titik sudut menunjukkan bahwa objek tersebut sedang aktif
sehingga dapat dilakukan perubahan (editing).

Lakukan perubahan (editing) pada objek. Ubah ukuran lingkaran sesuai dengan
besarnya titik yang akan Anda buat (misalnya ukuran diameternya 0,1 cm), dan
beri warna daerah bagian dalamnya dengan warna hitam. Caranya adalah sebagai

berikut:

Klik tab Colors and Lines: pada bagian
Fill, pilih Color Black. (gambar 3.40)

Klik dobel elip,

\ Klik zab Size: pada bagian Size and

(Pada MS Word 2007; t.rotate, isi Height dan Width = 0,1 cm

klik kanan objek, (gambar 3.39)
Format AutoShapes).

Format AutoShape

e \
Colors and Lines Size | Layout | . Web
Size and rotate
Height: O1em % width: 0dlem (%

Gambar 3.39 Format AutoShape pada tab Size

Colors and Lines | Size | Layout I Pickure | Text Box | Web I

Fill

Color: [ - |
Gambar 3.40 Format AutoShape pada tab Color and Lines
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o)
f. Diperoleh gambar : ﬁ
g. Klik di luar objek maka lingkaran kecil pada tiap titik sudut akan hilang sehingga

diperoleh gambar e.

Cobalah Anda praktikan!

2.

Catatan:
Karena objek yang digambar adalah titik, maka diameternya “sekecil mungkin

yang dapat dilihat”.

Menggambar garis

Berikut adalah langkah-langkah untuk menggambar garis lurus.

™~

a. Klik ikon ©* untuk garis atau ﬂ untuk garis berpanah. Cara lain adalah

dengan klik AutoShapes pada foolbar Drawing, l atau ﬂ (pada MS Word

2007: Insert ->.Shapes = l, ﬂ atau M). Pointer berubah bentuk menjadi
“+” dan geser menuju area kerja.

Letakkan pusat “+” di titik awal calon garis, tahan tekanan pada mouse, tarik
sepanjang garis yang diinginkan, lalu lepaskan tekanan pada mouse. Jika yang
Anda inginkan adalah garis vertikal atau horisontal, ketika menarik mouse, tekan
tombol | Shift |

Untuk melakukan perubahan warna dan bentuk garis, dobel klik objek sehingga
muncul jendela Format AutoShape (Gambar 3.41). Anda dapat mengubah
tampilan melalui pilihan Color, Dashed, Style, Weight, dan Arrow (garis
berpanah), pada tab Color and Lines. Sementara itu untuk perubahan ukuran dan
pemutaran objek dapat Anda lakukan melalui tab Size, dengan mengisikan

ukuran yang dikehendaki pada kotak teks yang tersedia. Cobalah Anda praktikan!

Catatan:
Dalam hal objek berbentuk garis, Height adalah jarak tegak antara titik
awal dan titik akhir pada untuk vertical, dan Width adalah jarak mendatar

antara titik awal dan titik akhir untuk posisi horizontal.
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Colors andLines | Sze || Layout | Proe | 1eiion | web |
il

Color: v

Iransparency: ¢ IR e

b e —]
Arrows
Bonsie: | — [3] e | — 3]

Begin size: ™ End size: v

Height

] Width
Gambar 3.41 Gambar 3.42
Jendela Format AutoShape Ukuran objek

3. Menggambar garis lengkung

Untuk menggambar kurva atau garis lengkung, ikuti langkah-langkah berikut ini.

a. Klik AutoShapes = Lines = Curve (pada MS Word 2007: Insert > Shapes

- Lines > ﬂ (Curve)). Geser pointer menuju halaman kerja (pointer
berubah bentuknya menjadi “+”).

b. Letakkan pusat “+” di titik awal calon garis, selanjutnya Anda klik pada setiap
lengkungan yang Anda inginkan, klik dua kali pada bagian akhir garis lengkung
yang akan Anda buat.

c. Ikuti langkah 3 seperti pada waktu menggambar titik di atas untuk melakukan

perubahan (editing). Cobalah Anda praktikan!

4. Menyisipkan Text Box

Gambar-gambar dalam naskah matematika biasanya disertai label-label untuk

memberi nama. Hal ini dapat dilakukan dengan memanfaatkan fasilitas Insert Text

Box. Caranya adalah dengan mengklik pada foolbar Drawing, bawa pointer ke
lembar kerja, klik dan tahan, seret mouse dan lepaskan, kemudian ketik teks yang
Anda inginkan. Anda dapat mengatur teks sebagaimana mengatur teks pada

umumnya. Tampilan kotak teks dapat diatur dengan cara: aktifkan Text Box, arahkan

t
pointer ke kotak teks sampai di ujung pointer muncul tanda *y”, klik kanan, klik
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|% Format Text Box... | sehingga muncul jendela Format Text Box (Gambar 3.43).
Untuk keperluan label pada gambar matematika, sebaiknya pada pilihan Fill Color
pilih No Color, pada Line Color pilih No Line dan pada tab Layout bagian
Wrapping Text pilih In front of text. Dengan pilihan terakhir ini, teks dapat digeser

ke manapun pada naskah.

Format Text Box X

[Colorsand Lines || size | Layout | Pitre | TextBox | web |
Fil

Colr O

Transparency: (€] 0% %l

Line

- e [
Dashed: | v: weight: 0.75 pt 2]

Gambar 3.43 Jendela Format Text Box

Pada MS Word 2007, ikon [A_::| terletak pada menu Insert kemudian pilih template
yang disediakan atau klik 2] Draw Text Box | geser pointer ke halaman kerja, klik

dan tahan, seret sehingga membentuk persegi panjang lalu lepas dan terakhir ketikan

teksnya. Cara memperbaiki tampilan sama dengan pada MS Word 2003 melalui
jendela Format Text Box dengan cara aktifkan Text Box, arahkan pointer ke kotak

t
teks sehingga di ujungnya muncul “4~ kemudian klik kanan, klik Format Text Box.

Contoh 1

Membuat dua garis saling tegak lurus
Untuk membuat dua garis tegak lurus, misalnya garis @ L a’, Anda dapat mengikuti

langkah-langkah berikut ini.

a.  Buatlah sebuah garis dan fext box bertuliskan “a” (font Times New Roman,

Italic). Format teks dengan Fill: No Fill, Line: No Line, Layout: In front of

text. Anda dapat menggeser garis dan teks dengan menekan tombol

, , , atau | (Gambar 3.441).

b.  Salinlah (Copy) garis pertama dengan cara:
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Cara 1: arahkan pointer ke garis hingga di ujung pointer muncul *I*, klik
kanan dan tahan, kemudian tarik ke posisi yang Anda inginkan dan
lepaskan, klik Copy Here.

Cara 2: aktifkan gambar, tekan [Ctrl[{c], [Ctrl}{v], geser menggunakan
tombol panah.

Cara 3: aktifkan gambar, klik kanan, klik Copy, klik kanan, klik Paste, geser
ke tempat yang Anda kehendaki.

Salin juga text box “a” dan ganti isinya dengan “a’” (Gambar 3.44ii).

c.  Aktifkan garis kedua (garis a'), pada toolbar Drawing, klik Q’i", klik
Rotate or Fip »|, klik 4% RotateLeft90°| pada MS Word 2007 perintah ini
dilakukan dengan klik dobel pada gambar, pada ribbon Format, pada

kelompok Arrange klik _Sh” kemudian klik 4 | Rotate Left 90°

Anda dapat juga merotasi dengan klik kanan pada gambar, klik
Format AutoShape, pada jendela yang muncul dalam tab Size, bagian
Rotation isikan nilai 90°, klik OK.

d.  Langkah terakhir, atur posisi dengan mengaktifkan gambar, kemudian gunakan

tombol-tombol panah (Gambar 3.444ii).

Gambar 3.44
Cobalah Anda praktikan!

5. Menggabungkan objek
Apabila Anda ingin memindah posisi kedua garis yang saling tegak lurus seperti pada
contoh di atas (garis ala’), Anda perlu menggabungkan (meng-group) kedua garis

dan labelnya terlebih dahulu. Cara menggabungkan beberapa objek adalah sebagai

berikut.
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a.  Pilih objek-objek yang akan digabungkan menggunakan Select Object IE,
sehingga gambarnya menjadi seperti Gambar 3.45.

b.  Selanjutnya klik Draw = Group (pada MS Word 2007: Format = Arrange
- Group). Cara lain adalah dengan klik kanan pada objek-objek yang sudah
di-select, klik Grouping—>Group. Hasilnya tampak seperti ditunjukkan
Gambar 3.45i11 atau Gambar 3.45iv. Adanya bulatan kecil delapan pada bagian

terluar menunjukkan bahwa objek tersebut sudah digrup/digabungkan.

Gambar 3.45 Tampilan sebelum dan sesudah digabung

(i dan ii di MS Word 2003, iii dan iv di MS Word 2007)
c.  Untuk memecah kembali objek tersebut klik Draw -> Ungroup (pada MS
Word 2007: Format > Arrange - Ungroup)
d.  Untuk menggabung kembali objek-objek yang telah di-ungroup, klik Draw -
regroup (pada MS Word 2007: Format = Arrange = Regroup).

Cobalah Anda praktikan!

6. Menggambar bangun datar

Sebelum Anda mulai menggambar, sebaiknya Anda melakukan pengaturan grid

terlebih dahulu (telah disinggung di kegiatan belajar 1).

Secara umum untuk menggambar bangun datar, yang Anda lakukan adalah mengklik
AutoShapes > Basic Shapes (pada MS Word 2007: Insert - Shapes -
Basic Shapes) kemudian pilih salah satu bangun datar yang Anda inginkan.

Terdapat beberapa teknik menarik dalam “menarik mouse” (klik mouse dan tahan,

tarik kemudian lepaskan). Cobalah beberapa kasus berikut. Untuk masing-masing
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kasus diawali dengan klik AutoShapes - Basic Shapes -2 O (rectangle),

kemudian bawa pointer ke area kerja.

Kasus 1: Tarik mouse dan lepaskan. Tindakan ini menghasilkan sebuah persegi
panjang yang ujung diagonalnya berada pada posisi titik awal menekan

mouse dan titik akhir melepas mouse.

Kasus 2: Tekan tombol + tarik mouse kemudian lepaskan. Tindakan ini
menghasilkan sebuah persegi dengan ujung diagonal di titik awal dan

akhir beturut-turut di posisi mulai menekan dan melepas mouse.

Kasus 3: Tekan tombol +tarik mouse kemudian lepaskan. Tindakan ini
menghasilkan persegi panjang yang “berpusat” di titik awal menekan

mouse, dan ujung diagonal di titik melepas mouse.

Kasus 4: Tekan tombol + + tarik mouse  kemudian lepaskan.

Tindakan ini menghasilkan persegi yang berpusat di awal menekan

mouse.

Cobalah juga menggunakan berbagai kombinasi grid setting, dan perlakuan menekan
tombol sambil menarik mouse. Sebagai contoh, atur grid di posisi snap to grid,
buatlah persegi panjang dengan tekan mouse kemudian tekan tombol dan tahan,
tarik mouse kemudian lepaskan. Apa yang terjadi? Anda dapat membuat persegi

panjang yang ujung diagonalnya tidak menempel di gridline.

Selain menggunakan mouse, Anda dapat menggeser bangun yang Anda gambar
dengan mengklik objek yang akan digeser kemudian tekan tombol , , ,
atau . Untuk geseran yang lebih halus gunakan kombinasi tombol +,

| Ctrl | He |, [CHrl | , atau . Cobalah Anda praktikan!

M

Contoh 2

Menggambar busur lingkaran dan juring
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Untuk menggambar busur dan juring gunakan fasilitas Arc yang terdapat di toolbar
Drawing. Untuk memunculkannya, klik menu AutoShapes, pilih submenu

BasicShapes, kemudian pilih Arc, sebagaimana

terlihat pada Gambar 3.46. X T ’
}gT Connectors 4 .
Pada MS Word 2007: Klik Insert pada baris & Bshe Noooo
B, Block Arrows OO AN
menu, klik Shapes, klik Basic Shapes, klik Arc. Zo Elowchart rOO OO
% Stars and Banners » 8900
. . . 2y Callouts » D O0O@
Busur elips dibuat dengan menarik mouse tanpa + [Perre— O (
menckan tombol yang lain. Busur yang telah  awsshes=|\ x 0 O D) O
o select several objects. [Eh { }

dibuat dapat diperpanjang dengan menarik ujung Gambar 3.46
belah ketupat kecil berwarna kuning. Untuk

membuat juring elips, busur yang telah dibuat diklik (diaktifkan) kemudian klik
kanan untuk membuka jendela Format AutoShape dan pada bagian tab Color and
Lines, pilih warna yang Anda kehendaki. Objek yang telah dibuat dapat juga diputar

dengan lingkaran berwarna hijau.

Busur dan juring lingkaran dibuat dengan cara yang sama, hanya saja ketika menarik

mouse kombinasikan dengan menekan dan menahan tombol | Shift|.

Cobalah Anda praktikan!

Gambar 3.47 Busur dan juring
7. Menggambar segitiga siku-siku
Untuk menggambar segitiga siku-siku Anda dapat menggunakan fasilitas Right

Triangle: |E| Fasilitas ini terdapat di AutoShapes—>Basic Shapes>Right Triangle
(pada MS Word 2007: Insert->Shapes->Basic Shapes>Right Triangle). Langkah

menggambarnya adalah sebagai berikut.
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a. Klik AutoShapes—>BasicShapes2>Right Triangle |E| Geser pointer ke
halaman kerja (pointer berubah bentuknya menjadi “+”).

b. Letakkan pusat “+” di titik awal calon garis, tahan tekanan pada mouse, tarik
sepanjang garis diagonal sehingga berbentuk segitiga yang diinginkan, lalu
lepaskan penekanan pada mouse.

c. Untuk mengetahui ukuran segitiga tersebut klik dobel objek (pada MS Word
2007, klik kanan objek), pada kotak dialog Format AutoShape klik fab Size,
selanjutnya lihat pada bagian Height dan Width. Ubahlah pada bagian tersebut
untuk mengganti ukuran segitiga.

d. Untuk memindah sudut siku-sikunya agar tidak selalu di sebelah kiri bawah maka
dapat dilakukan dengan Rotate or Flip (Draw -> Rotate or Flip, pilih salah satu
di antara beberapa pilihan yang ada). Pada MS Word 2007 klik dobel objeknya,

pada fab Format, di kelompok Arrange klik ﬂi, klik salah satu pilihan yang

ada.
B _/‘
a a a’
Segitiga Awal Flip Horizontal Rotate Left 90°
Gambar 3.48
Cobalah Anda praktikan!

8. Menggambar bentuk bangun datar yang tidak terdapat pada Basic Shapes

Untuk menggambar bentuk bangun datar yang tidak terdapat pada Basic Shapes
diperlukan beberapa trik. Berikut diberikan beberapa contoh.

Contoh 3

Gambarlah bangun berikut ini.
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Langkah-langkah untuk menggambar bangun di atas adalah sebagai berikut.

a.

Gambar sebuah persegi dan beri arsiran dengan cara klik kanan pada objek,
Format AutoShape, pada tab Color and Lines: Color pilih Fill Effect sechingga
muncul jendela Fill Effect. Pilih zab Pattern, pilih arsiran yang diinginkan, klik
OK, klik OK (Gambar 3.491).

Pada MS Word 2007: klik kanan pada objek, klik Format Object, pada jendela
Format Object tab Color and Lines klik Fill Effect, pada jendela yang muncul
masuk ke 7ab Pattern dan pilih arsiran yang diinginkan, klik Ok kemudian akhiri
dengan klik OK.

Gambar sebuah busur seperempat lingkaran. Isi busur dengan warna putih.
Biarkan busurnya tetap memiliki “garis busur”.

Pindah busur tersebut dan tempelkan ke persegi. (Gambar 3.491ii).

Jika sisi persegi tidak tertutup oleh juring seperti pada gambar 3.49ii (dekat
pointer), hilangkan outline (garis tepi) persegi dengan cara mengklik pada persegi

(Gambar 3.49iii). Gambar sisi persegi secara manual dengan Freeform melalui
Autoshape = Lines =2 Freeform @, klik di ujung busur, klik di sudut-sudut
berikutnya pada persegi, klik dobel untuk mengakhiri Freeform (Gambar 3.491i1).
Langkah ini tidak diperlukan jika sisi di sudut persegi telah tertutup oleh juring.

w

-

Gambar 3.49

Cobalah Anda praktikan!
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Contoh 4

Gambarlah bentuk berikut

3 cm

Gambar 3.50

Langkah-langkah untuk menggambar bangun di atas adalah sebagai berikut.

g.

Gambar persegi panjang dengan ukuran lebar 4 cm dan tinggi 3 cm seperti
berikut (Gambar 3.511).

Selanjutnya gambar busur dengan ukuran sama dengan persegi panjang yang
telah dibuat diatas (Gambar 3.511i)

Salin (copy) busur tersebut, kemudian diputar 180° (Gambar 3.511i1)

Tempelkan kedua busur tersebut pada persegi panjang sehingga gambarnya
menjadi seperti Gambar 3.51iv (tanpa arsiran).

Arsiran dibuat menggunakan Freeform (AutoShapes = Lines = Freeform).
Pada MS Word 2007: Insert > Shapes - Lines - Freeform). Buatlah bentuk
gambar (bangun dengan garis warna merah, Gambar 3.51v) menggunakan
Freeform pada kedua busur.

Editlah bangun tersebut dengan menggunakan Edit Point seperti Gambar 3.51vi
sehingga bentuknya seperti kedua busur. Selanjutnya beri arsiran sehingga
terlihat seperti gambar 3.51vii. Langkah terakhir, klik objek freeform, hilangkan
garis tepinya dengan pilihan pada Line dipilih No Line. Jika busur tertutup oleh
arsiran, klik objek freeform, klik kanan, klik Send to back.

Tulisan “4 cm” dan “3 cm” dibuat menggunakan Text Box.

Cobalah Anda praktikan!
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3cm

Gambar 3.51
9. Menggambar bangun ruang

Sebagaimana menggambar bangun datar, untuk menggambar bangun ruang sederhana
dapat dilakukan dengan mengklik AutoShapes = Basic Shapes kemudian pilih salah
satu bangun ruang yang diinginkan. Langkah-langkah untuk menggambarnya seperti

pada contoh menggambar segitiga siku-siku.

Contoh 5
(Menggambar bentuk bangun ruang yang tidak terdapat pada Basic Shapes)

Gambearlah bola seperti berikut ini.

1
1
L
0
0
U
]
0

Gambar 3.52
Langkah menggambarnya sebagai berikut.
a. Pertama-tama gambar lingkaran luarnya.
b. Selanjutnya gambar cincin mendatarnya menggunakan Arc (ada dua Arc, yaitu

bagian depan dengan utuh dan bagian belakang dengan garis putus-putus).
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c. Gambar cincin tegaknya. Caranya sama seperti langkah b.

d. Gabungkan (group) semua objek yang telah digambar. Cobalah Anda praktikan!
Contoh 6

Gambarlah balok seperti berikut.

H G
E '\\ /,
I F,
| \| ¢
N7/
3,5cm A%
/ \
| / \
Dk/- ---\
—" C
4 3em B

Gambar 3.53
Langkah menggambarnya sebagai berikut.
a. Untuk memudahkan menggambar, tampilkan grid-nya.
b. Buatlah rusuk-rusuk balok dan diagonal-diagonalnya menggunakan garis (Line).

c. Huruf pada tiap-tiap sudut dan tulisan ukurannya dibuat menggunakan Text Box
(dibuat No Line dan No Fill) agar tidak menutupi gambar.

Cobalah Anda praktikan!

10. Memberi arsiran transparan
Cara memberi arsiran pada suatu objek telah dibahas bagian sebelumnya. Selanjutnya

bagaimanakah cara untuk membuat arsiran yang transparan?

Untuk membuat transparan pada arsiran atau warna dapat dilakukan dengan cara

sebagai berikut.

Klik dua kali (double click) untuk mengaktifkan objek yang arsiran atau warnanya
akan dibuat transparan, klik kanan, klik Format AutoShape, pada fab Colors and
Lines bagian Fill: Transparency geser scroll bar-nya atau isikan nilai persentase

pada Transparency (semakin besar persentase, semakin transparan).
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Contoh 7

Menggambar daerah yang memenuhi pertidaksamaan y >-3x+6,dan y > —-x+4.

Dalam hal ini daerah yang diarsir adalah daerah yang tidak memenuhi kedua

pertidaksamaan tersebut.

a. Sebelum mulai menggambar, ada baiknya Anda mengatur jarak antar grid dan
aktifkan fasilitas Snap To Gridlines terlebih dahulu. Hal ini akan sangat
membantu karena garis-garis yang dibuat akan menempel ke grid sehingga
menjadi lebih rapi.

b. Lukis grid seperti pada Gambar 3.541, sumbu koordinat dibuat berwarna hitam,
sedangkan garis-garis yang lain dibuat lebih terang agar tidak mengganggu
pandangan. Supaya lebih cepat membuat petak-petaknya, mulailah dengan
membuat sebuah garis horisontal dengan warna abu-abu terlebih dahulu. Aktitkan
garis tersebut, kemudian tekan , rapikan posisinya menggunakan tombol
panah, tekan kembali +@ secukupnya. Lakukan hal yang sama untuk garis-
garis vertikal. Berikutnya lukis sumbu-sumbu koordinat.

c. Lukis kedua garis. Agar perpotongannya tepat, mulai dan akhiri di titik potong
dengan sumbu koordinat (Gambar 3.54ii).

d. Perpanjang masing-masing garis, dengan menarik ujung-ujungnya. Agar arah
(gradien) garis tidak berubah, tekan dan tahan tombol ketika menariknya
(Gambar 3.54iii).

e. Gunakan Freeform untuk melukis jajar genjang dengan masing-masing garis

sebagai salah satu sisinya (Gambar 3.541v).

f. Isi masing-masing jajar genjang dengan arsiran yang berbeda (Gambar 3.54v).
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(1)

T

(iv) (v) (vi)
Gambar 3.54

g. Untuk masing-masing arsiran, klik kanan, melalui Format Object (atau Format
AutoShape) aturlah transparansinya menjadi 50%. Perhatikan bahwa sumbu
koordinat, garis pertama dan kedua masih terlihat kurang jelas karena tertutup
arsiran. Untuk itu, klik kanan pada masing-masing objek, klik Order, klik Bring
to front agar menjadi jelas (tidak tertutup objek lain). Langkah terakhir, perbaiki
tampilan dengan memperpanjang masing-masing sumbu koordinat, memberikan
teks keterangan yang diperlukan dengan memanfaatkan Text Box. Untuk menulis
persamaan garis gunakan Text Box diisi ekspresi matematika yang ditulis dengan

Equation 3.0 (Gambar 3.54vi).

Cobalah Anda praktikan!
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11. Menggambar grafik fungsi kuadrat

Ketika Anda menggambar menggunakan fasilitas Lines, terkadang hasilnya belum

sesuai dengan yang Anda harapkan. Sebagai contoh, Anda ingin mengambar fungsi

kuadrat y=x* pada diagram kartesius. Untuk melukis kurva lengkung persamaan

kuadrat, digunakan fasilitas AutoShape > Lines = Curve.

a

W Y
\ Vi
4
P
Gambar 3.55

Langkah selengkapnya adalah sebagai berikut.

a.

Gambar sumbu koordinat dan grid dengan warna yang lebih terang seperti pada
contoh sebelumnya.

Kurva parabola tersebut melalui titik-tittk  (-3,9),(-2,4),(-1,1),
(0,0),(1,1),(2,4),(3,9). Klik AutoShape - Lines = Curve, klik di koordinat
(-3, 9), lanjutkan klik di (—2,4), lanjutkan klik di (=1, 1), dan seterusnya. Jika
terjadi kesalahan, misalkanya yang seharusnya klik di (2,4) Anda mengeklik di
tempat lain seperti Gambar 3.56ii, maka cara memperbaikinya adalah dengan
mengklik pada kurva parabola, kemudian klik kanan, klik Edit Point, pada titik-
titik di mana Anda klik akan terlihat noktah hitam. Anda dapat menarik titik

tersebut menggunakan mouse dan meletakkan di posisi yang tepat.

Cobalah Anda praktikan!
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¥ da

s TINATTe
(@) (i)
¥ y

(1i1) (iv)
Gambar 3.56

C. Ringkasan

Salah satu program aplikasi yang mempunyai fasilitas untuk menggambar dan
pengunaannya cukup mudah dan sederhana adalah MS Word, dengan adanya
fasilitas Drawing. Hal ini dapat dimanfaatkan untuk membantu mempercepat

penyediaan gambar dalam naskah matematika yang akan Anda buat.

Kebanyakan bangun-bangun matematika sudah dapat digambar menggunakan
fasilitas Drawing yang terdapat pada MS Word 2003 maupun 2007. Pada MS Word
2003 fasilitas untuk menggambar terdapat pada toolbar Drawing, sedangkan pada
MS Word 2007 fasilitas untuk menggambar terdapat pada fab Insert. Dengan

menggunakan berbagai teknik sebagaimana telah dijelaskan modul ini Anda dapat

menggambar berbagai bangun matematika dengan berbagai macam variasi.
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Selamat berkreasi!

D. Soal Latihan

Gambarlah bentuk-bentuk bangun berikut ini:

1. 2.

A

3 cm

Diameter
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7. Ini merupakan 8 H G
salah satu : \\ ,/'
Lol bentuk diagram E — o
- ! /
V : \\V,/
T ! v N
I/ 7 \
X 1 4 \
§ I \
I \\
I \

\
\
\
\
\
\
\
‘-a
/\
N
! ~
! N
oy i N
,
’

A

Bidang diagonal dibuat transparan.
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E. Umpan Balik

Gambar-gambar pada soal latihan ini masih belum sempurna. Sebagai contoh
penggunaan notasi derajat yang masih menggunakan angka 0 di-superscript dan
penggunaan huruf non-/talic pada notasi titik. Anda dapat membuat yang lebih baik.

Pembahasan lebih detail soal-soal ini disediakan pada lampiran.
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A. Rangkuman

Microsoft Word (MS Word) telah dilengkapi dengan fasilitas untuk menulis naskah
matematika. Anda dapat membuat ekspresi matematika menggunakan simbol dan
Equation. Selain itu, MS Word juga menyediakan fasilitas Drawing yang dapat
digunakan untuk memberi ilustrasi yang berupa berbagai macam bentuk geometris

maupun kurva matematis.

Untuk mengoptimalkan proses menulisan simbol, MS Word telah menyediakan
fasilitas shortcut, AutoCorrect, dan Math AutoCorrect (untuk versi 2007).
Terdapat lebih dari 200 item Math AutoCorrect dalam Word 2007. Selain
menggunakan shortcut dan AutoCorrect bawaan MS Word, Anda dapat juga

membuat shortcut dan koreksi otomatis sendiri sesuai kebutuhan.

Fasilitas Equation tersedia dalam MS Word untuk membuat ekspresi matematika
yang tidak mungkin dibuat dengan hanya mengandalkan fasilitas Insert Symbol.
Dalam Equation tersedia berbagai template, karakter dan simbol, serta operator
untuk keperluan penulisan naskah matematika. Seperti halnya dalam fasilitas

Symbol, berbagai shortcut tersedia untuk mempercepat pekerjaan penulisan naskah.

Tampilan dan cara penggunaan Equation Editor untuk MS Word 2003 dan MS
Word 2007 memiliki banyak perbedaan, termasuk dalam hal kompatibilitasnya.
Namun demikian, MS Word 2007 masih menyertakan Microsoft Equation 3.0
(yvang digunakan pada MS Word 2003 dan sebelumnya). Perlu sedikit pembiasaan
bagi Anda yang terbiasa menggunakan Microsoft Equation 3.0 untuk berpindah ke
Equation dalam MS Word 2007.

Bermacam gambar untuk ilustrasi naskah matematika dapat dibuat baik pada MS
Word 2003 maupun MS Word 2007 dengan cara mengkombinasikan berbagai
fasilitas Drawing yang tersedia. Posisi perintah-perintah Drawing pada MS Word
2003 terletak dalam toolbar Drawing, sementara itu pada MS Word 2007 terletak

pada tab Insert.
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B. Penilaian

Kerjakan soal-soal berikut. Jika Anda mengalami kesulitan, Anda dapat membuka

penjelasan pada modul-modul yang diberikan.

1. Tulisan di dalam kotak di

samping diambil dari salah 1. Panjang dua pasang sisi berdtfiatan_sanli,
vaitu AB=AD dan BC=DC. 48 = 4D, BC
satu Buku Sekolah e

Elektronik. Pada soal nomor | 2. Sepasang sudut yang berhadapan sama
ukuran, vaitu ukuran ZABC = ukuran

1, terdapat penulisan yang ZADC. 2 ABC = # ADC.

3. Salah satu diagonalnya membagi layang-
layang menjadi dua sama ukuran, vaitu

ekspresi matematika yang AABC = AADC atau AC merupakan sumbu

simetri.

tidak wajar, karena terdapat

terputus di tepi kanan dan

dalam penggunaan font. Salinlah dengan format yang sama dan tidak ada ekspresi
matematika yang terputus pada margin kanan.

2. Salinlah ekspresi matematika berikut ini menggunakan Equation Editor.

18ab® = 2x 9 xaxbs = 2% 3% x q % b
faldoricas prima

3. Salinlah ekspresi matematika berikut ini menggunakan Equation Editor.

(330

4. Buatlah ckspresi matematika berikut ini menggunakan Equation Editor.
Perhatikan bahwa posisi operator untuk tiap baris terletak sekolom.
4 - Qab + 3b°
-2a° + 3ab - 47 _

6a® - Sab + TH

5. Berikut ini adalah salah satu soal yang diambil dari Buku Sekolah Elektronik.

Salinlah dengan format yang sama.
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1. Pada gambar jayargenjang ABCD berilout,
ADYEFGH y BC .

a, Sebutlkan pasangan-pasangan sudut
dalam berseberangan!

b, Jika diketahui

LDAB : £LABD 1 LADB =3 : 2.7,
hitunglah zudut pada titik J dan J!

6. Pada kotak di bawah ini diberikan naskah yang dari salah satu Buku Sekolah
Elektronik. Terdapat ketikdakkonsistenan penggunakan font dan formatnya.
Salin dan perbaikilah.

Pada A ABN berlaku
AB2= ANZ+ BN2
BM2= AB? - AN?

BN2= AB? - (AL + NL)
Karena NL = BK maka

BN = [AB?-(AL-NLP

BN = ,[aB?-(AL+BK)?
KL = BN

Jadi | KL= [AB? ~(AL+BK}

atau

d=ua® —(R+r)?

dengan a : jarak antar pusat kedua
lingkaran
R : jariqari lingkaran besar
r @ jari-ari lingkaran kecil

Untuk soal nomor 7 sampai dengan 10, gambarlah bangun-bangun yang ada dalam
Microsoft Word.
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10.

Selamat! Anda telah mempelajari seluruh isi modul, mengerjakan latihan dan soal
yang diberikan. Anda berhasil mempelajari modul ini jika minimal dapat
menyelesaikan 75% dari latihan dan soal yang diberikan. Jika mendapatkan kesulitan,
Anda dapat membuka kembali modul-modul tersebut, berdiskusi bersama teman

sejawat atau menghubungi penulis melalui alamat e-mail ontongts@yahoo.com atau

Joko Purnomo dengan alamat e-mail joko purnomo_ 01@yahoo.com.
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Bantuan Pengerjaan Soal-soal
Latihan (Modul 3)

1. Untuk membuat sumbu koordinat Cartesius x, y dan z dengan sudut antara y dan z

45° adalah sebagai berikut.

a. Buat garis tegak dengan anak panah tunggal ke arah atas (sebagai sumbu y).
b. Gandakan (copy-paste) garis tersebut sebanyak dua kali.

c. Salinan garis pertama diputar —90° (sebagai sumbu x).

d. Salinan garis kedua diputar —45° (sebagai sumbu z).

¢. Tulisan x, y, z, 45° dibuat menggunakan Text Box (No Line, No Fill).

f. Garis putus-putus dibuat menggunakan Arc.

2. Menggambar segi delapan beraturan.

a. Tampilkan grid untuk memudahkan dalam melihat ukuran gambar.
b. Buat lingkaran dengan jari-jari 2 cm (diameter 4 cm) untuk bantuan (No Fill).
c. Buat garis putus-putus sepanjang 4 cm mendatar dalam lingkaran yang

melalui pusat lingkaran.

d. Gandakan (copy-paste) garis tersebut sebanyak tiga kali.
e. Salinan garis pertama diputar —90°

f. Salinan garis kedua diputar 45°

g. Salinan garis ketiga diputar —135°

h. Buat garis pada ujung-ujung garis terdekat

—_-

Hapus lingkaran yang telah dibuat.

j.  Untuk memberi warna isi segi delapan gunakan Free Form.

3. Menggambar diagram Venn.

a. Buat persegi panjang (No Fill).
b. Buat dua buah lingkaran (No Fill), letakkan kedua lingkaran tersebut seperti

pada soal.
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c. Buat titik menggunakan lingkaran dengan isi (Fill) warna hitam.

d. Huruf dan angka dibuat menggunakan Text Box.

4. Menggambar kerucut:

a. Buat lengkung bagian depan dan belakang menggunakan Arc.

b. Ujung kerucut ke alas dibuat menggunakan garis (Line).

5. Menggambar diagram lingkaran.

a. Tampilkan grid untuk membantu dalam menggambar.
b. Buat lingkaran dengan diameter 3 cm.

Buat garis tegak sepanjang 3 cm melalui titik pusat lingkaran.
d. Gandakan garis tersebut sebanyak dua kali.

e. Salinan garis pertama diputar —30°, letakkan garis tersebut melalui pusat
lingkaran.

f. Salinan garis kedua diputar 30°, letakkan garis tersebut melalui pusat
lingkaran.

g. Buat garis mendatar sepanjang 1,5 cm melalui titik pusat lingkaran.

h. Buat garis double arrow mendatar sepanjang 3 cm diletakkan di bawah
lingkaran.

i.  Semua tulisan dibuat menggunakan Text Box.

j. Warnai masing-masing juring dengan menggunakan Arc.

6. Menggambar segitiga.

a. Buat garis mendatar (garis 4B).

b. Gandakan garis tersebut sebanyak dua kali.

c. Salinan garis pertama diputar 60°. Letakkan garis sehingga ujung bawah garis
menempel pada ujung garis mendatar sebelah kiri.

d. Salinan garis kedua diputar —40°. Letakkan garis sehingga ujung bawah garis
menempel pada ujung garis mendatar sebelah kanan.

e. Atur panjang kedua salinan garis sehingga bertemu pada satu titik.

f.  Semua tulisan dibuat dalam Text Box (No Fill, No Line).

g. Tanda panah dibuat menggunakan Arc.
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7. Membuat diagram Venn.

a. Komentar dibuat menggunakan Callout.

b. Buat lingkaran (No Fill), dan gandakan dua kali.
Susun ketiga lingkaran seperti pada soal latihan.

d. Beri arsiran (transparan) pada setiap lingkaran.

e. Huruf dibuat dalam Text Box.

8. Menggambar balok dengan diagonal ruangnya.

®

Tampilkan grid untuk membantu menggambar.

o

Semua rusuk dibuat menggunakan garis (Line).
Pewarnaan bidang menggunakan Free Form.

d. Semua tulisan dibuat dalam Text Box.

9. Menggambar grafik fungsi kuadrat.

a. Untuk menggambar papan berpetak lihat bagian (1)e pada KB 1 Modul 3.
Mengambar papan berpetak.

b. Garis sumbu dibuat menggunakan garis dengan anak panah tunggal di ujung.
Titik-titik koordinat dibuat menggunakan lingkaran kecil diisi warna hitam.

d. Tulisan dan angka dibuat dalam Text Box (No Line, No Fill).

e. Grafik dibuat menggunakan Curve.

10. Menggambar seperempat elips.

a. Bangun yang berwarna hijau adalah seperempat elips, digambar menggunakan
Arc.

b. Papan berpetak dibuat menggunakan garis (Line) dengan bantuan grid.
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